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GRANT OF LICENSE. As registered user, the author grants to you the right to use one
copy of the enclosed software program (the "SOFTWARE"). You may not network the
SOFTWARE or otherwise use it or make it available for use on more than one computer
at the same time.
DSP-AudioEditor COPYRIGHT. The SOFTWARE is owned by Stefano Daino, via
Romeo Rodriguez Pereira 129/C - 00136 ROME - ITALY, and is protected by Italian
copyright laws and international treaty provisions.
Therefore, you must treat the
SOFTWARE like any other copyrighted material (e.g. a book or musical recording) except
that you may either (a) make one copy of the SOFTWARE solely for backup or archival
purposes, or (b) transfer the SOFTWARE to a single hard disk provided you keep the
original solely for backup or archival purposes. You may not copy the written materials
accompanying the software.
OTHER RESTRICTIONS. You may not rent, lease, sell or transfer the SOFTWARE to
other persons. You may not modify, adapt, translate, reverse engineer, decompile, or
disassemble the SOFTWARE.
DISCLAIMER OF WARRANTY AND LIMITED WARRANTY. THE SOFTWARE AND
ACCOMPANYING ELECTRONIC AND WRITTEN MATERIALS (INCLUDING
INSTRUCTIONS FOR USE) ARE PROVIDED "AS IS" WITHOUT WARRANTY OF ANY
KIND.
FURTHER STEFANO DAINO DOES NOT WARRANT, OR MAKE ANY
REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF
THE SOFTWARE OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS,
ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE.
THE ABOVE ARE THE ONLY WARRANTIES OF ANY KIND, EITHER EXPRESSED OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE THAT ARE MADE
BY STEFANO DAINO ON DSP-AudioEditor PRODUCT. NO ORAL OR WRITTEN
INFORMATION OR ADVICE GIVEN BY THE AUTHOR, ITS DEALERS, DISTRIBUTORS,
AGENTS, OR EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY
INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON SUCH
INFORMATION OR ADVICE.
THIS WARRANTY GIVES YOU SPECIFIC LEGAL
RIGHTS. YOU MAY HAVE OTHER RIGHTS, WHICH VARY FROM STATE TO STATE.
NEITHER THE AUTHOR NOR ANYONE ELSE WHO HAS BEEN INVOLVED WITH THE
CREATION, PRODUCTION, OR DELIVERY OF THE SOFTWARE SHALL BE LIABLE
FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES
(INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS
INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT
OF THE USE OR THE INABILITY TO USE THE SOFTWARE EVEN IF THE AUTHOR
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME
STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR
CONSEQUENTIAL OR INCIDENTAL DAMAGES OR THE LIMITATIONS OF DURATION
OF IMPLIED WARRANTY, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.
OTHER TRADEMARKS AND COPYRIGHTS:
- DSP-Quattro is Copyright © 2002-2022 by Stefano Daino. All rights reserved.
- D-SoundPRO is Copyright © 1998 by Stefano Daino. All rights reserved.
- Apple and all other copyrights and trademarks are held by their respective holders.
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Introduction
Welcome to the DSP-AudioEditor User’s Guide. DSP-AudioEditor is the
direct result of a very long experience developing Digital Audio applications
for the MacOS, starting in ’94 with D-SoundPRO, the powerful audio editor
developed for Apple MacOS. DSP-AudioEditor introduces the new
dimension of real-time into the world of audio editors, turning your computer
into a real time workstation for music production, plug-in hosting and audio
editing. All of the above through the smoothest interface you have ever seen.
DSP-AudioEditor is designed for the most professional users, however,
thanks to the simple and intuitive interface, DSP-AudioEditor turns out to be
the ideal product for whoever has no experience in the field and would like to
enter in the world of digital audio.
This User’s Guide will show you all there is to know about DSP-AudioEditor.

What is DSP-AudioEditor?
DSP-AudioEditor is an extremely powerful Audio Editor application with
extended real-time and off-line support of Audio Unit (AU) Effect plug-ins for
the Apple MacOS.
- DSP-AudioEditor is a real time audio editor.
DSP-AudioEditor is the right software for all people who want to record,
create or edit their audio files using a Mac. With DSP-AudioEditor you can
record audio sources, edit existing audio files, create new audio files as well.
All these using various existing formats, such as WAVE, AIFF, CAF, mp3,
m4a, iTunes Plus AAC, etc.
You will then be able to edit the new file starting with the basic Cut,
Copy&Paste commands, to the most advanced algorithms, as the Time
Stretching, Frequency and Pitch Shifting, Linear Phase Sample Rate
Converter (SRC), and Digital Real Time Effects, like reverbs, stereo
enhancers, graphic and parametric EQs, Analog Filter Simulators, and so
on. And it is all built-in!
But not only that: DSP-AudioEditor is able to host standard third parties plugins as well. DSP-AudioEditor Editor allows you to use any plug-in exactly as
any other internal edit function, offering also a real time preview of the result
before to apply it.
And, if you will not like the result, you have not to worry: DSP-AudioEditor
internal engine keeps track of all edits and you can Undo/Redo your edits
without any limitation.
- DSP-AudioEditor is a tool for software and hardware samplers:
For all those among you that have already experienced music and both
hardware and software samplers, DSP-AudioEditor is the perfect editing
tool. In fact, DSP-AudioEditor offers not only a way of processing in floating
point precision to satisfy even the more professional user, it offers also all
the graphical tools for the sample-based editing of your audio files. You will
be able to set loop points through a special loop editor window, and apply
any internal or plug-in effect directly to your samples! DSP-AudioEditor
guarantees the direct compatibility of audio files such as AIFF and WAVE,
including the loop points information.
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About Third Parties AudioUnit Plug-Ins formats
DSP-AudioEditor is capable to support Effects plug-ins. These plug-ins can
be used as real time modifiers or as offline edit function with real time
previewing. More about this will come later on this manual.
DSP-AudioEditor supports Effects Audio Unit (AU) 64 bits plug-ins.

What do I need to use DSP-AudioEditor?
DSP-AudioEditor works on any Apple Macintosh with an Intel or Apple
Silicon (M1 or newer) microprocessors running MacOS 10.11 (El Capitan) or
higher. It is a universal application, it runs natively also on Apple Siliconbased Macs.
The minimum requirements are: a CPU Intel (or M1 Apple Silicon), 4GB of
RAM, and around 50 MBytes of free space on your HD.
The audio and graphic engines of DSP-AudioEditor run at 64 bits and are
multithread. If present, DSP-AudioEditor will use the CPU multicores.
Please consider also that the performances of DSP-AudioEditor are heavily
dependent by the number of plug-ins and effects that are used at the same
time.
Mac standard audio interface can be used with DSP-AudioEditor by
CoreAudio, which is built-in in the MacOS.
DSP-AudioEditor supports also all the external hardware audio interfaces if
compatible with MacOS.

What do I need to know to use DSP-AudioEditor?
This User’s Guide assumes that you know how to operate the Macintosh
and are familiar with the basic Macintosh terminology such as point, click,
drag & the MacOS file system and desktop. If you aren’t familiar with these
terms, you should refer to the Macintosh User’s Guide to learn the basic
operations of using the Macintosh. This User's Guide assumes also that you
know what technologies like AudioUnit and, if you are interested to use
external audio devices, what Core Audio are.

Support:
DSP-AudioEditor official home page is:
www.DSP-Quattro.com
Here you can find additional information on our product.
At any time write us by e-mail at support@DSP-Quattro.com to have the
answer to your technical questions or for more information regarding the use
of DSP-AudioEditor.
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The Editor window
The Editor window is the worksheet of DSP-AudioEditor. A worksheet is a
container which includes all the objects you need to accomplish your work.
At startup, DSP-AudioEditor automatically creates an empty Editor window.
Then, you load your audio files on this Editor window to work on them.
Closing an Editor window or quitting the application, DSP-AudioEditor asks if
you wish to save or discard the edits which you have done on these audio
files.
The command to create a new Editor window and to close it are on the top
bar of the application, under the File menu:

where:
-

New Editor (or ⇧⌘N): to create a new empty Editor window and
worksheet. DSP-AudioEditor will ask if you wish to save or discard your
edits before to open a new empty worksheet, if any.

-

Close Editor (or ⇧⌘W): to close the current Editor window and
worksheet. DSP-AudioEditor will first ask if you wish to save or discard
your edits, if any.

On this menu there is also a command
-

Open Audio File… (or ⌘O): to open an audio file into a new Editor
window if there is not yet an open Editor window - or on the current Editor
window if there is already one open. DSP-AudioEditor will show a file
browser to be able to choose one or more audio files to add on the
current worksheet (more about this later in this manual).

-

Open Recent Audio File: the application keeps track of the last used
audio files. Using this menu, you can reload the most recently used audio
files.

NOTE: it is not possible to have more than one Editor window open at the
same time. For this, closing an Editor window and its worksheet, DSPAudioEditor will first ask if you wish to save the edits made on current audio
files, if any.

The worksheet
The Editor uses one main window, the worksheet. Even if DSP-AudioEditor
also uses some additional accessory floating windows like the Loop tool or
custom plug-in GUIs, most of the work is done on the main worksheet.
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The worksheet consists of:
-

The Document Manager: the Document Manager shows a list of the
audio files which are open in DSP-AudioEditor.

-

The Audio File Editor main view: it is the main view of the worksheet. It
shows the waveform of the audio file under editing.

-

The Transport Bar and Tool buttons: this view consists of the buttons
to control the playback, the display to show information about current
marker or playback cursor position and of the tool buttons to show/hide
the views on the bottom part of the Editor window and additional tools
and dialogs of the application.

More about these views in the following chapters of this manual.
NOTE: it is possible to show, hide, resize each one of the above
components of the Project Document window. It is possible to resize their
sub views as well. Just click and drag with the mouse the border of the view
to resize it.

Each component has its own menu commands
The top application menu bar contains only the commands for the Editor
window management and for the options which are related to the
application, like the preferences and the audio settings.
Menu commands are at the top of the view where they apply. This means,
as an example, that the commands to make an editing on an audio file are
on top of the main Audio Editor view, the commands to manage the audio
files loaded into the worksheet are on top of the Document Manager view,
and so on.
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Next chapters will deeply describe each view of the worksheet, as well as all
the related menu commands.

The Editor Window is a container of documents, not a document by itself.
When you wish to edit your audio files, you open them into the Editor
window. You must consider that it is not possible to save e reload an Editor
as independent entity.
After editing an audio file, as soon as you will close it or when you will close
the Editor window which contains it, you must choose to save it or discard
the edits.
DSP-AudioEditor keeps track of the source audio file which are under
editing. Saving the edits done on an audio files, the source audio file will be
replaced by its edited version.
In other words, the audio files are the documents managed by DSPAudioEditor, and not the Editor window. The last is not a document, but only
a container of documents, the audio files.
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The Document Manager
On the left part of the worksheet, there is the Document Manager panel.
By default, when DSP-AudioEditor opens a new Editor window, the
Document Manager panel is visible. Use the leftmost button on the top of the
Editor window to show/hide the Document Manager panel:

To show/hide it, you can also drag the right border of the Document Manager
panel view.
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The Document Manager shows a list of the audio files which are used in
DSP-AudioEditor at a certain moment.
If the audio file has been already loaded on the audio file editor waveform
view, a green dot on the left of the audio file name is visible.
For each audio file on the Document Manager table, there is a blue Info
button on the right of the audio file name. Placing the mouse pointer on it,
DSP-AudioEditor will show the file path of the source audio file. Clicking on
it, DSP-AudioEditor will reveal the position on the MacOS finder of that audio
file.

Document Manager Commands
In the upper part of the Document Manager panel there two buttons, one to
Add a new element on the Document Manager table, one to Remove the
current selected elements from the table.
Clicking on the Commands button on the top of the Document Manager
table, it is possible to select one of the following commands:

-

New Audio File: to create a new audio file. This audio file will be a
temporary file until it is saved. After pasting some audio material on this,
closing it, closing the Editor window or quitting the application, DSPAudioEditor will ask to “save as” it, or to discard it.

-

Open Audio File…: to load an audio file from file system. DSPAudioEditor will show a file browser, allowing you to select an audio file
to add to the Document Manager file table.

-

Import Audio File from Dual Mono L&R…: to load a stereo audio file
using two mono audio files, one for the left channel, one for the right
channel (dual mono). DSP-AudioEditor will show a file browser asking to
choose two audio files, then will add a reference to a temporary dual
mono audio file to the file table.
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-

Import Audio File from Binary File…: to load a mono/stereo audio file
from a raw binary audio file. DSP-AudioEditor will show an additional
dialog to set the parameters which it needs to play correctly the file:

where:
Bytes Order: can be LittleEndian (as used mostly on Windows and Intel
and Silicon-based Macs) or BigEndian (as used mostly by old PowerPCbased Macs)
Bit Depth: 8, 16, 24, 32 or 32 floats - the bit depth of each sample on the
binary file.
Stereo/Mono: set the number of interleaved audio channels.
Sample Rate: set the sample rate used to play the audio file
First Sample Offset: set an offset to start reading samples from the
binary audio file. Set this value if the binary audio file has a header in
front of the audio sample which DSP-AudioEditor must skip looking for
samples.
On the right of this panel, there is a button to Set the current values to
the values used by the DDP standard. Use these settings if you are
importing the binary audio file generated exporting as DDP (Btw you
should use the “import DDP” function of the AudioCD Layout to do it).
-

Select Items…: the commands on the sub menu apply to the audio files
which are currently selected on the table. It is possible to:

-

Export… : it is equivalent to do a “Save As…”. It is necessary to select
an audio file on the table before to export it. Please refer to the chapter
about File commands on the Audio Editor main view later in this manual
for the details.

-

Show Source File on the Finder: DSP-AudioEditor will reveal the
position on the MacOS finder of that audio file.

-

Revert To the Source Audio File: use this command to discard any
changes made after the last save command.

-

Rename…: to rename the current item selected item on the file table

-

Open on the Audio File Editor: to load the selected item(s) on the
audio file waveform editor and show it.

-

Remove: this command will remove the selected item(s) on the file item.
In case, before to remove the item(s), DSP-AudioEditor will ask to save
or discard the changes, if any.
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-

Remove All: this command will remove all the items which are on the
file table, empty it. In case, before to remove the item(s), DSPAudioEditor will ask to save or discard the changes, if any.

It is also possible to click on a certain audio file on the file table while
keeping the right button pressed to show a menu with a sub-set of the above
commands:

Using Drag&Drop to Import/Export audio files
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It is possible to drag&drop audio files between the Document Manager file
table or the audio file waveform editor view and the MacOS file system, on
both directions:
A - Dragging one or more audio files from the desktop or from a folder on the
file table of the Document Manager will load the file audio in the current
worksheet. The result is the same as using the command Import Audio
File. If you wish then to open these audio files on the Audio Editor waveform
view, double click on the new file names inserted on the Document Manager
table.
B - Dragging one or more audio files from the Document Manager table to
the desktop or to a folder, DSP-AudioEditor will export these audio files. If a
file having the same name already exists (if, for example, you drag the file to
the same folder of the source file), DSP-AudioEditor creates a new file
having the same name of the source file with an increasing number added to

To play forward at normal speed
First click: to stop
Second click: to move the playback cursor to
the beginning of the file.

To play forward and reverse at double speed.
To move the playback cursor to the next or
previous marker or - if any - to the beginning
or end of the current selection or - if any - of
the file.
To toggle On/Off the Cycle Mode. If the Cycle
Mode is On, the playback cursor, reaching the
end of the portion to play, jumps at start
continuing to play. If Off, it stops at end.
To toggle On/Off the Audio Scrub Mode (slow
motion mode). When slow motion is ON, the
playback speed - on both directions – is
controlled by the speed control, the slider
which is positioned at the bottom of the
waveform view.
To toggle On/Off the preroll. If the preroll is
ON, pressing the play button, DSPAudioEditor starts to play 2 secs in advance
respect the current playback position.
the end of the destination file name.
Once opened an audio file in an Audio File Editor view,
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A - Dragging one or more audio files from the desktop or from a folder on the
Audio Editor waveform view, DSP-AudioEditor imports the audio file into the
current Project AND will opens the audio file in a new Audio Editor waveform
view tab.
B - On the Audio Editor waveform view, clicking on a waveform selection
without moving the mouse, after around 2 seconds the mouse pointer will
change to an hand. It is therefore possible to drag the selection from the
Audio Editor to the desktop or to a folder. In this case, DSP-AudioEditor
exports the selection in a new audio file with the same name of source file. If
it already exists (if, for example, you drag the file to the source folder), DSPAudioEditor creates a new file having the same name of the source file with
an increasing number added to the end of the destination file name.
C - Moreover, dragging the selection over the Document Manager table
instead of the MacOS file system, DSP-AudioEditor exports the selection
into a temporary audio file which is internal to the current worksheet. It is
possible to use this as shortcut to create new files trimming the portions of
the audio to export.
NOTE: it is even possible to drag the selection of only one channel of a
stereo file to export only that channel (or a part of it).
D – The above points B) and C) work also if the is not a selected waveform
on the Audio Editor waveform view. In this case, DSP-AudioEditor will export
the audio file from the beginning up to the end. This feature is very useful as
shortcut to the Audio Editor command ‘Export Audio File As…’, because it
saves a copy of the current audio file as it is in that moment.
You are highly recommended to spend some moments making some
practice with the extended Drag&Drop support in DSP-AudioEditor for
exporting files. It is an irreplaceable tool to incredibly speed up your edits.
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The Transport Controls
The transport controls are in the upper part of the Editor window. This
section consists of the transport bar and the counter displaying the position
of the current marker or playback cursor as well as loop and playback points.

The Transport Bar:
On the left part of the control section, there is the transport bar, which
consists of the buttons to control the playback:
NOTE: Also the keyboard controls the playback:
-

Space Bar: toggles Play/Stop. If it stops, the playback cursor returns to
the position where the playback started.

-

Return Key: to stop the playback.
At the bottom of the waveform view, there is the speed control, a slider which
controls the playback speed:

When DSP-AudioEditor plays at normal speed, moving the speed control to
the right causes the increase of the playback speed - as well as the pitch.
Moving it to the left causes the decrease if the playback speed as well as of
the pitch. Releasing the mouse, the speed control returns to center. Keep
the CMD key pressed while dragging the speed control to lock it at the last
position when realising the mouse.
If the Audio Scrub button on the transport bar is ON, DSP-AudioEditor plays
in slow motion. In this case the speed control works as jog-shuttle. If it is
centered, the playback is on stop (playback speed = 0). Moving the speed
control to the right, DSP-AudioEditor will play in slow motion, forward.
Moving it to the left DSP-AudioEditor will play in slow motion, backward.
Using the ribbon controller, DSP-AudioEditor plays the audio file at a
different pitch and speed. Raising the pitch implies a faster speed and
shorter time duration, and vice versa. It is also possible to change the pitch
without modifying also the speed - and time length - just using the Pitch
Shifting processing function on the Processing menu. This processing
function will be explained later in this manual.

The Counter Display
At the center there is the Counter Display, which shows the position of the
playback cursor or of the current marker.
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The Counter Display shows the position of the playback cursor in the main
part. In the two smaller sections on the right, there are the positions where
DSP-AudioEditor currently cycles playing the file. Clicking on any marker on
the waveform editor view, the information on the Counter Display - name and
position – will change accordingly. Clicking and dragging the mouse on the
waveform view and making a waveform selection, the display shows the
length of the new selection on the main part, while the counters on the right
show the selection start and end.

The default time unit is hours:minutes:seconds:milliseconds
(HH:MM:SS:MSEC). Possible choices are Frames, Seconds, Milliseconds or
AudioCD (CDDA).
Use the menu command
Options->X-Axis Unit->…
which is on the application menu bar
to make your selection.
On DSP-AudioEditor Preferences, it is possible to enter the default value for
X-Axis units used by DSP-AudioEditor creating new Editor windows.
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The Audio Editor waveform view
If you have not already loaded an audio file into the AudioEditor, DSPAudioEditor will show an empty AudioEditor view:

To edit an audio file you need to load it first into the Project. This can be
done by a two steps procedure, or by using a single command of DSPAudioEditor, it will do both steps one after the other automatically.
1 - Two Step procedure:
first load an audio file into the Document Manager, then open it into the
AudioEditor doing one of the following actions:
-

double-click on the audio file name on the audio file table
drag the file name from the audio file table to the Audio Editor
waveform view.

2 - SingleStep procedure:
-

use the menu command File->Open Audio File… on the top application
menu bar:
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-

use the command on the popup menu control File->Open Audio File…
on the top of the AudioEditor main view:

NOTE: it is also possible to use the commands on the File->Import sub
menu to import a dual-mono and a Raw data audio file:

Please refer to the chapter about the Document Manager commands for a
detailed explanation of these commands to Import.
-

use the command OpenAudioFile… on the down arrow popup menu
control on the top right of the Audio Editor waveform view:

DSP-AudioEditor will open a file browser. Select the audio files you wish to
edit.
NOTE: You can select multiple files by ⇧+Clicking or ⌘+Clicking on the file
names.
This window interface features these main areas:
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-

The waveform overview: in the upper part of the audio file editor there is
an overview of the audio file under editing. During all editing operations
the overview will show you the waveform of the whole audio file, from start
to end. The overview zooms in or out automatically if the file changes its
length doing changes.

-

The Audio File Editor waveform view area: in the middle part of the
audio file editor there is also the waveform view which, differently from the
overview, allows to zoom-in or zoom-out on any region of the audio file.
When the waveform zooms, the underneath scroll bar can be used to
scroll the view along the x-axis, back and forth in time. The audio file
editor waveform area is the main part for the edits. It is possible to set the
level of zoom very easily by using the mouse wheel, by using the
commands in the menu, by the keyboard, or clicking on the zoom buttons
located in the lower right angle of the waveform view area.

-

The Audio File Editor channel strip: in the left part of the Audio File
waveform view, there is a channel strip, with the gain sliders and VuMeters section. More about the channel strip later in this manual.

The Channel Strip
On the left part of the Audio File editor waveform view there is a channel
strip. Use the channel strip to set the gain, the pan-pot and the other
parameters and features - as a serial chain of real-time effects - used by
DSP-AudioEditor to play the audio file under editing.
Each audio file under editing has its own channel strip having different
settings.
On the lower part of the channel strip there are the Gain sliders and VU
Meters:
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The Gain sliders, Peak and RMS VU-Meters and other controls
Using the Gain Sliders and VU Meters on the channel strip is very intuitive:
Using the Gain Sliders:
-

Click&Drag: clicking and dragging the Gain Slider knob will change the
gain of the channel according to the dB scale.

-

CTRL + click: to jump to the default +0dB value.

Using the numerical control above the Gain Slider:
-

Click: a small dialog will prompt you to enter a new numerical value,
expressed in dB (float number).

Peak and RMS Meters:
On the right of the Gain slider there are the Peak and RMS Meters. They
show the peak and RMS levels of the left and right signals on DSPAudioEditor output. The peak meters are innermost respect the RMS
meters.
Peak meters show the max level of the audio signal, computed with the
precision of the sample. They have a release time such that when the signal
decreases, they follow smoothly. As soon as the signal increases, they
immediately update the displayed value.
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RMS meters show the power of the audio signal. An audio signal can have
very high peak levels (even up to the distortion) but very low RMS values. In
this case, they sound poor and weak. A good mastering engineer is able to
rise the RMS level without causing the distortion. Usually, multi-band
compressors plug-ins can help a lot to reach a good balanced result.
In the upper part of the Vu-Meters there is a number that shows the peak
value in dB. This number remains fixed to the highest reached value for 3
seconds. Then, it will return to show the current maximum value. In
Preferences, it is possible to set a flag to keep this value fixed to the
maximum. In this case, to reset it, click on it.
Also there is a red peak level indicator that flashes if the signal reaches or
exceeds 0dB. Be careful not to let these indicators flash too often because,
even if DSP-AudioEditor, just like analog devices, uses a special clipping
algorithm any abuse of the output levels will cause the saturation and
distortion in the audio output signal.
The Panpot Rotary Control:
On top of the Gain slider there is a rotary control, the pan-pot, to set the
balance between the L&R channels. Possible values are in the range
[-1.0..1.0], where -1.0 means that the only the L channel will play, 0 means
that the L&R output signals are equally balanced, and +1.0 that only the R
channel will play.
It is also possible to click on the numerical value into the rotary control to
enter the exact pan-pot value.
ON/OFF button:
It turns On/Off the audio on output from the channel strip.
Mute button:
Use this button to mute/un-mute that channel strip.
Mono button:
Use this button to mix the L&R channels into a single mono channel, which
will play on both L&R channels on the channel strip output. This is very
useful to verify the mono compatibility of the output audio signal.
L&R Phase Invert button:
At the bottom of each VU-Meter there is a button with a Ø sign. Tuning ON
this button will invert the phase of that audio channel. Use this button to
check if there is a frequency cancellation when inverting the phase of one
channel. These buttons are very useful when used in combination of the
Mono button.
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The Audio Overview view
The waveform overview is in the uppermost section of the Audio Editor
waveform view.

This view is a waveform view without the zoom in/out control.
It is possible to use the waveform overview to make new waveform
selection, move the markers or the playback cursor, and set the zoom level
for the main waveform view area below.
At the top of the waveform there is the Time Ruler. DSP-AudioEditor uses
the same X-Axis unit used for the Counter Display control. As described into
the corresponding chapter, to set the X-Axis unit for the time ruler, use the
application menu command
Options->X-Axis Units…
Possible choices are
-

HH:MM:SS:MSEC (hours:minutes:seconds:milliseconds)
Frames
Seconds
Milliseconds
AudioCD (CDDA)

On the right side there is the Level Ruler, that shows the level of the signal
accordingly to the Y-Axis unit. To set the Y-Axis unit,
use the menu
command
Options->Y-Axis Unit…
Possible choices are
-

Floats, normalized into the range [-1.0..1.0[
dB (decibel).

Below the waveform display, there is a special Zoom Controller, that can be
used to set the zoom level of the main waveform view area. This control
highlights in orange the region that the main waveform view area displays.
By clicking on it and then dragging the mouse, DSP-AudioEditor set the
zoom level of the main waveform view scrolling it accordingly.
Using the Zoom Controller
It is easy to use the zoom controller:
-

hover the mouse over the zoom controller, the mouse pointer changes to
a magnifying glass.

-

clicking on it and dragging the mouse, the control draws an orange
region. Then, releasing the mouse button, the main waveform view scrolls
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to the position corresponding to the orange rect start, zooming up to the
position corresponding to the orange rect end.
!" + mouse click and dragging, scrolls the main waveform view to the
region pointed by the mouse, without modifying the zoom level.

-

The Main Audio Editor Waveform view

As we have seen for the overview, the main Audio Editor waveform view
area shows the waveform of the current audio file. This view however is able
to zoom in any part of the waveform, up to one samples per pixel and even
more. Both x and y axes have an independent zoom levels. The vertical axis
can be zoomed-in without limits, it is even possible to see the quantization
noise in the audio file.
To zoom in/out:
-

Use the mouse wheel: it sets the horizontal X-Axis zoom-in/out ratio.
The same can be done moving vertically 2 fingers on the Apple Trackpad,
if any. Use ⌘ + mouse wheel to set the vertical Y-Axis zoom-in/out ratio.

-

Use the +/- buttons: use the +/- at the bottom right of the waveform view
to zoom in/out horizontally on the X-Axis or vertically on the Y-Axis.

-

Use the menu commands: clicking on the Commands button which is
on top of the waveform overview, a popup menu appears, and it possible
to use one of commands on the Zoom sub menu:
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-

X-Axis/Y-Axis Zoom In/Out will increase or decrease the zoom in/out
ratio by a factor 2 (it will magnify the waveform by a factor x2 or will
zoom-out by a factor x0.5)

-

Full Zoom In/Out: it is a shortcut to the maximum/minimum possible
level.

Both functions are available for the X-Axis X (horizontal), Y-Axis (vertical) or
in pair (XY-Axis Full Zoom Out).
There are also some functions to fit the zoomed area to a special region of
waveform:

-

-

Fit On Selection: to zoom in/out on the current selection. This
command is not available if there is not a selection.

-

Fit On Loop: to zoom in/out on the loop region. This command is not
available if the loop is turned OFF.

Using the Keyboard shortcuts: you can use the keyboard as shortcut
to the above menu commands.

After zooming the waveform, the scroll bar a the bottom of the main
waveform view lets you to scroll the view to another position.
Do not forget to use the Zoom Controller on the upper waveform overview
view for immediate zoom in/outs!
NOTE: you can scroll the view also by clicking and dragging the Time Ruler.
The effect is the same as using the scroll bar, but often it is smoother and
very much more precise.
If it is playing, the Audio Editor waveform view area will scroll following the
playback cursor.
In the left area at the bottom of the main waveform view, you can see
information such as the sample rate, bit depth and total length of the audio
file under editing.
The button AutoZero lets you to toggle On/Off the AutoZero options when
placing markers and selection start/end (more about this later in this
chapter).
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The Info button opens the side panel on the right of the main waveform view,
described here below.
Making a waveform selection
A “selection” is a region of the audio file which we wish to edit. Most of DSPAudioEditor editing functions work on the selection, if any. Otherwise, they
works on the whole audio file.
There are several ways to do a selection: clicking and dragging the mouse,
using menu commands or using keyboard key commands.
It is possible to make a selection on the main waveform view area or on the
waveform overview. Since both views refer to the same file, a selection done
on a waveform view will be visible also on the other waveform view as well.
Doing a selection on the main waveform view area, dragging the mouse
pointer outside the right or left borders, the view will scroll. The scrolling
speed will increase/decrease accordingly to the distance outside the border.
NOTE: If the is already a selection, ⇧+click will extend the selection up to
the mouse pointer. If there isn’t already a selection, ⇧+click creates a new
selection between the playback cursor and the mouse pointer.

NOTE: you can also independently select the left or right channel of a stereo
audio file. To select only the right channel, click and drag on the topmost part
of the waveform of the right channel. To select only the left channel only,
click and drag the lower part of the waveform of the left channel. In the case
of a selection of only the left or right channel, if applicable, the edit function
will process only that channel.
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Clicking and dragging the mouse, doing a selection, the Counter Display will
show in real time the selection length, start and end points.
NOTE: double-click with the mouse to select the portion of waveform
between the two nearest markers. If there are none, all the waveform is
selected. A triple mouse click always selects all the waveform.
Clicking on the Commands button which is on top of the waveform overview,
It is possible to use the following commands to do selections:
Select All (or ⌘A):
To create or extend the current selection to all the waveform.
Select Loop (or ⇧⌘A)
available only if loop is On, to select the region between start and end loop
points.

The audio file Info side panel
Clicking on the Info button which is at the top left of the waveform overview
view (or on the rightmost button among the buttons located at the top left of
the worksheet, marker with an Info symbol), a side panel will open on the
right of the waveform view itself. This side panel has some tab buttons.
Clicking on each of them, the view below switches among the Info, Markers,
Regions and MIDI views.
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The same button used to open the side panel will close it if pressed again.
The Info panel is divided into two main parts:
-

On top there are read-only info: source audio file path, audio file name,
the length expressed in hh:mm:sec:msec and frames units, the audio file
format, sample rate and bit depth.

-

The lower part shows user editable settings: CD-Texts and ID3 Tags.
Click on the editable field to enter the new value, then hit return (or click
outside the popup view used to enter the new text) to confirm.

NOTE: please consider that exporting the audio file, not all audio file formats
support the CD-Texts and ID3 Tags information.

Working with Markers
Two other tabs on top of the side panel switch to the Markers or Regions
views.

There are several types of markers:
-

The Playback Cursor (the RED marker) - always positioned at the
current playback position.

-

Generic Markers (BLUE markers) - a generic marker is identified by a
location and a name.

-

Region markers (ORANGE start and end markers) - a region is a
portion of the audio file which is identified by two markers, one at region
start, one at region end, and by a region name.
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-

Loop markers (YELLOW start and end markers) - A Loop is a portion
of the audio file to cycle when playing it. It is identified by two markers,
one at loop start, one at loop end.

NOTE: DSP-AudioEditor is compliant with the standards when it reads/writes
markers information from/to PCM uncompressed audio files (AIFF, WAVE,
CAF). These audio files can be exchanged among different applications and
software/hardware samplers, maintaining the information about loop and
other markers.
NOTE: DSP-AudioEditor gives you an option of Auto Zero. When this option
is ON, releasing the mouse after moving a marker or setting the selection,
DSP-AudioEditor automatically shifts the cursor point to the previous zerocrossing point. A zero-crossing point is the location in which the waveform
intersects the zero level changing the sign. This option is very useful to place
markers in positions that have the zero level in common.
To activate the Auto Zero option, use the Auto Zero button at the lower left of
the main waveform view, or use the menu command Options->Auto Zero,
or to use the combination of keys ⌘U. This command toggles the AutoZero
ON/OFF.
The Markers view shows the Loop and the Generic Markers, the Regions
view shows the Regions markers.
On the Marker view there are two main parts: on top there is a part to show
the current values of the playback cursor, of the loop markers (they are
visible only if the Loop is ON) and the start and end values of the waveform
selection, if any. The bottom parts has a table showing the Generic markers
list, and a Command button to work on the Generic markers.
To edit the value of a marker position, click on the numerical field of the
value. DSP-AudioEditor will show a popup, where it is possible to type a new
value. Use the tab key to move from one field to the next, the enter key to
close the popup.
Menu commands to move the playback cursor:
There are several menu commands to move the playback cursor at specific
points of the audio file.
Clicking on the Commands button on top of the waveform view, and then on
the Playback Cursor submenu, it is possible to:
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Go To Start:
to move the playback cursor at audio file start.
Go To Next Marker (or ⌘K):
to move the playback cursor to the position of the next marker.
Go To Prev Marker (or ⇧⌘K):
to move the playback cursor to the position of the previous marker.
Go To Selection Start:
to move the playback cursor to the current audio selection start. This
command is not available if there is not an audio selection on the waveform.
Go To Selection End:
to move the playback cursor to the current audio selection end. This
command is not available if there is not an audio selection on the waveform.
Go To Loop Start:
to move the playback cursor to the Loop start. This command is not
available if the Loop is OFF
Go To Loop End:
to move the playback cursor to the Loop end. This command is not available
if the Loop is OFF
Among Loop options on the Markers side panel, there are also the buttons to
turn On/Off the loop (the yellow start/end loop markers will appear/disappear
on the waveform views) and to lock/unlock the loop points and loop length.

If one or both start/end loop markers are locked, the corresponding marker
cannot be dragged or moved. And, if the loop length is locked, setting the
start loop marker position will set also the end loop marker accordingly. Of
course, the reverse is also true.
The Generic markers table
At the bottom of the Markers side panel, there is the Generic markers table:
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All fields are editable. Just click on the filed to edit it, DSP-AudioEditor will
show a popup to enter a new value.
On the right of each generic marker name there is an arrow which turns on
red if the corresponding generic marker is the current selected generic
marker. If you click on a blue generic marker on the waveform view, that
becomes a selected generic marker.
NOTE: it is possible to define a group of generic markers, selecting them at
the same time, just keeping the ⌘ or the ⇧ key pressed while clicking on
the arrow on the left part of the generic marker row - or on top of the blue
generic marker on the waveform view.
If there are more than one generic marker selected, dragging one of them on
the waveform view will also make all the others slide along the time axis.
Generic markers can be locked. In this case, it is not possible to change
their position, and it is not possible to move or drag them on the waveform
view. If in a group there is a locked generic marker, it is not possible to move
any of the others as well.
The Generic markers commands
Clicking on the Commands button on top of the generic markers table, DSPAudioEditor shows the following menu:

Use these menu commands (menu items are greyed-out if the command not
applicable in a certain situation) to:
New At Playback (or ⌘M):
to create a new generic marker at playback cursor position
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New At Selection Bounds (or ⌃⌘M):
If there is a selection, it creates two new generic markers at selection start
and end positions. This command is not available if there is not a waveform
selection.
New At Selection Start:
if there is a selection, it creates a generic marker at selection start. This
command is not available if there is not a waveform selection.
New At Selection End:
if there is a selection, it creates a generic marker at selection end. This
command is not available if there is not a waveform selection.
New At Loop Bounds (or ⌥⌘M):
if the Loop is On, it creates two new generic markers at loop start and end.
This command is not available if the Loop is OFF.
New At Loop Start:
if the Loop is On, it creates a generic marker at loop start. This command is
not available if the Loop is OFF.
New At Loop End:
if the Loop is turned On, it creates a generic marker at loop end. This
command is not available if the Loop is OFF.
Select All:
to select all the generic markers. This command also groups them all
together.
Unselect All:
to un-select all generic markers. This command is not available if there are
not selected markers.
Remove Selected (or ⌥⇧⌘M):
to remove (delete) the selected generic marker(s). This command is not
available if there are not selected markers.
Remove All (or ⌃⇧⌘M):
to remove (delete) all generic markers
Lock Selected:
to lock the selected generic markers. This command is not available if there
are not selected markers.
Unlock Selected:
to unlock the selected generic markers. This command is not available if
there are not selected markers.
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Markers To Regions:
to create new regions from the generic Markers on the list. Each region will
extend from one generic marker to the next one on the list, and so on, one
after the other.
Selected Markers To Regions:
as above, with the difference that only the selected markers are considered.
Markers List to New Project Audio Files:
to create new audio files from the generic markers list, one for each marker.
Each new audio file will extend from one generic marker to the next one on
the list.
Export Markers List As Audio Files…:
to export to MacOS file system new audio files from the generic markers list,
one for each marker. Each new audio file will extend from one generic
marker to the next one on the list. Then, DSP-AudioEditor shows a dialog
with the options to export the audio files and to ask a destination. Please
refer to the chapter describing the options available to export audio files for
the details.
Copy Selected:
to copy the list of selected generic markers into a special clipboard built-in
into DSP-AudioEditor. This special clipboard is dedicated only to the generic
markers. After copying a list of generic markers into the marker clipboard, it
will be possible to paste this list from the clipboard into a new audio file.
Copy All:
as above, with the difference that this command copies all the generic
markers into the marker clipboard.
Paste:
to paste the list of the generic markers which are memorised into the marker
clipboard into the current audio file. This command is not available if the
marker clipboard is empty.
The same commands are available from the Commands button on top of the
waveform view:
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Working with Audio Regions
As already introduced, an audio region is a portion of the audio file which is
identified by two markers, one at region start, one at region end, and by a
region name.

The Audio Regions table
One of the tabs on top of the Info side panel switch to the Audio Regions
view. DSP-AudioEditor allows you to add and remove audio regions, edit
region name, show/hide the region markers on the waveform view. There
are also several commands dedicated to audio regions.
Each row on the table is dedicated to the parameters of an Audio Region :

Click on the arrow on the left side of the audio region row to expose/collapse
the details about the audio region start and end positions, and the region
length.
Click on the blue check mark on the right of the audio region row to show/
hide the audio region markers (the orange markers) on the waveform view.
The minus (-) button on the right of the audio region row will remove (delete)
that audio region.
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You can edit the audio region name, start, end and length values just clicking
on the corresponding text or value. DSP-AudioEditor will show a popup view
to enter the new value.
The Audio Regions commands

Clicking on the Commands button on top of the Audio Regions table, DSPAudioEditor shows this menu:

New From File (or ⌥⇧⌘U):
to create a new audio region starting at audio file start and ending at its end.
New From Selection (or ⌥⌘U):
to create a new audio region starting at selection start and ending at
selection end. This command is not available if there is not a waveform
selection.
New From Loop:
to create a new audio region starting at Loop start and ending at Loop end.
This command is not available if the Loop is Off.
Show All (or ⌃⌘U):
to make all the audio region markers visibile on the audio waveform view.
Hide All (or ⌃⇧⌘U):
to hide all the audio region markers on the audio waveform view.
Remove Visible:
to remove (delete) all visible audio regions.
Remove All:
to remove (delete) all audio regions.
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Region List to New Project Audio Files:
to create new audio files from the audio regions list, one for each audio
region.
Export Region List to Audio Files…:
to export to MacOS file system a list of new audio files from the audio
regions list, one for each audio region.
The same commands are available from the Commands button on top of the
waveform view:

Working with the Loop
When it play an audio file, DSP-AudioEditor uses two different concepts for
cycling on a certain region of an audio file: the Loop and the Cycle.
The Cycle Mode and the Loop
The Loop is a region of the audio file to cycle when playing it. It is identified
by two markers, one is the loop start, the other one is the loop end (the
yellow markers on the waveform view). These two markers are saved into
file, and into the Project.
Also the Cycle is a portion of the audio file to cycle when playing it, BUT it is
not identified by any marker. It is simply a region which DSP-AudioEditor will
play again and again without any interruption.
The Loop can be ON or OFF accordingly to the status of the On/Off button
on the audio file Info side panel, among Markers settings:
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The Cycle can be ON or OFF accordingly to the state of the Cycle button on
the Transport bar:

Q: When DSP-AudioEditor plays cycling on the Cycle instead of
cycling on the Loop?
A: let’s start from the rule which DSP-AudioEditor follows to play:
1) If there an audio selection, DSP-AudioEditor plays that audio selection
ONLY, starting at the start of the audio selection and ending at selection
end.
Then, if the Cycle is ON, DSP-AudioEditor plays cycling on that audio
selection. If the Cycle is OFF, it stops as soon as it reaches the end of the
selection. This will happen no matter if the Loop is On or Off.
2) If there is not an audio selection, DSP-AudioEditor plays the audio file
starting at the beginning of the audio file. Then:
- If the Loop in ON, DSP-AudioEditor plays cycling on the Loop (yellow
markers on the waveform view).
- If the Loop is OFF, DSP-AudioEditor plays the audio file up to the end,
then it will cycle starting again at the beginning of the audio file ONLY if
the Cycle button is ON.
- If both Loop and Cycle button are OFF, DSP-AudioEditor will stop to
play as soon as it reaches the end of the audio file.
NOTE: if there is an audio selection on the waveform view, DSP-AudioEditor
plays that selection only, cycling on it if and only if the Cycle button is ON.
NOTE: and, if there is an audio selection on the waveform view, when
playing that selection, DSP-AudioEditor does not consider the Loop (yellow
markers) settings, even if the Loop is ON.
The Loop commands
Clicking on the Commands button on top of the waveform view, DSPAudioEditor shows a menu which includes the following commands for
Looping:
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Turn Loop ON/OFF (or ⌘L):
to toggle the Loop ON and OFF. If the Loop has been turned ON, the two
Loop markers (the yellow markers), will appear on the waveform view.
Otherwise, DSP-AudioEditor will hide them.
Lock Loop Length (or ⌥⇧⌘L)
to lock/unlock the length of the Loop. If the Loop length is locked, moving
any one of the two Loop markers, the other one will move accordingly. This
option is useful in the case that, once you have found a good Loop, you wish
to shift the Loop without changing its length. This command is not available if
the Loop is OFF.
Loop Selection (or ⇧⌘L):
to place the Loop markers at the current selection start and end. (This
command is not available if there is not a selection on the waveform view). If
the Loop is turned Off, it will automatically be turned On.
Show/Hide Loop Window (or ⌥⌘L):
to show or hide the Loop floating window tool. More about this here below.
The Loop Window
DSP-AudioEditor gives you a special tool for setting Loop points: the Loop
Window and a very special X-Fade Looping tool. In this chapter the Loop
Window will be described. To know about the X-Fade Looping tool, please
refer to the chapter describing the X-Fade Looping processing function of
DSP-AudioEditor.
This tool allows you to monitor the waveform in correspondence of the Loop
points.
NOTE: the window is a floating window. It means that it is always visible on
top of the Editor window. At the same time, it is also possible to work on the
waveform Editor view.
Any operation done on the waveform Editor view, like dragging a Loop
marker, will result in a real time change in the Loop window, and vice versa.
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This window consists of two parts, the left and right parts, divided by a
yellow marker that corresponds to the loop point, where DSP-AudioEditor
jumps back cycling: the left side of the view shows the final part of the
waveform just before the Loop End point, the right side of the view shows
the part of waveform which is immediately after the Loop Start point.
When playing the Loop, DSP-AudioEditor plays the samples up to the Loop
End point, then it jumps and plays without any interruption from the sample
at the Loop Start point. The Loop Window shows you what DSP-AudioEditor
plays when it reaches the Loop point, showing the visual continuity of the
waveform at loop. If the two points of start and end loop don't coincide or
don’t grant a continuity to the waveform, as for example in the first above
figure, it is clear that a very unpleasant click will be heard at loop point, when
DSP-AudioEditor will cycle jumping from the loop end to the loop start.

On the other hand, if the loop points are placed in such way to guarantee a
continuity to the waveform, as shown in this second figure, we may expect
that there won’t be any audible click playing the loop, when DSP-AudioEditor
jumps from the loop end to the loop start.
Unfortunately the visual continuity is not always sufficient to guarantee that
the Loop will play without clicking, but surely the Loop Window is an
essential tool to set the loop points at very good positions.
After doing this, it is also possible to use the X-Fade Looping algorithm of
DSP-AudioEditor to produce a Loop which plays absolutely perfect. Of
course, a certain experience is necessary to find the “perfect" Loop,
especially for audio files which are harmonically complex, as in the case of
samples of orchestral strings or of an acoustic piano.
The Loop Window has its own vertical Y-Axes zoom level. To do vertical
zoom in/out, use the two -/+ buttons on the lower right part of the Loop Tool
window.
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There are also two custom transport bars to move the start/end points. One
for setting the loop end, below the left view, one for setting the loop start,
below the right view.
Respectively, from left to right, these buttons allow you:
- to Move the Loop point on the previous zero crossing point. A zero-crossing
point is the location in which the waveform intersects the zero level changing
the sign. This option is very useful to place markers in positions that have
the zero level in common, if the the slope of the curve is the same at the end
and loop positions. The waveform of a perfect loop has always the same
level and same slopes at loop points, and the point of zero crossing can be
very useful for having a common reference point for placing both start and
end loop points.
- To quickly move the Loop point backward.
- To slowly move the Loop point backward.
- To slowly move the Loop point forward.
- To quickly move the Loop point forward.
- To move the Loop point to the next point of Zero Crossing.
NOTE: you are able to drag forward or backward the Time Ruler of every
Loop view. The respective Loop point will move accordingly.
NOTE: to place the loop points in the right places is only the first step to
have a file playing perfect when jumping at loop. After placing the loop
markers, use the X-Fade looping algorithm (see the processing function in
the following chapters) to smooth the waveform at loop. Surely, the result will
surprise you.
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Editing an Audio File
This chapter describes in deep all the editing functions offered by DSPAudioEditor and how to use them.

Audio File Formats
DSP-AudioEditor loads audio file previously saved using almost all known
formats, starting from the PCM uncompressed formats, like AIFF, WAVE,
CAF having 8, 16, 24, 32 and 32 float bits/sample, and any sample rate, to
compressed audio file formats as mp3, MPEG-4, mp2, ac3, aifc, 3gp, mpa,
mp4, 3g2, m4a, AAC…
DSP-AudioEditor takes care to do all necessary conversion loading an audio
file, and this process is totally invisible to you.
As a special option, DSP-AudioEditor is able to import an audio file as RAW
data. It means that DSP-AudioEditor will read the file, loading it sample by
sample without looking for any audio file header, as it usually does. It is
useful to recover corrupted PCM files where the header is no longer valid.
The RAW data import DOES NOT work at all the formats which are not
PCM-based, ie if the source file is using any technique to encode or
compress. See the following paragraph to know how to import an audio file
as RAW data.
When DSP-AudioEditor needs to edit an audio file, it imports the source
audio file into a temporary area, translating it to the internal uncompressed
CAF 24 bits audio file PCM format. This is because the CAF guarantees the
maximum audio fidelity and supports to audio long files. This means that you
can work with audio files without any reasonable restriction on its length, as
it happens if using the standard AIFF and WAVE formats.
In fact, AIFF and WAVE formats are limited to 2.1 GB for the single audio file
and which is, working at 24bits/96kHz, a little bit more than 1 hour only.
Instead, CAF audio files can be as long as needed, so you can work with
even hours and hours of music at 24bits/96kHz without any problem.
Playing an audio file, DSP-AudioEditor plays always in sync with the current
audio device. It means that its internal audio engine works at the same rate
of the current audio device. If the sample rate of the audio file is not equal to
that of the current audio device, DSP-AudioEditor applies a real time sample
rate conversion (SRC) to play the audio file at the correct pitch.
NOTE: the sample rate of the current audio device and sample rate of the
current audio file should have always the same value, otherwise DSPAudioEditor, playing that audio file, needs to process the audio stream with
its SRC algorithm and you do not hear EXACTLY what you are going to save
on the audio file after your edits.
So, it would be always important to set the sample rate of the current audio
device to the same value of the current audio file under editing OR to
resample the audio file under editing to the sample rate of the current audio
device using the off-line SRC algorithm of DSP-AudioEditor (it is a very high
quality linear phase SRC) before to do your edits with it.

Undo/Redo
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DSP-AudioEditor always allows to undo changes, using the Undo
command (or ⌘Z). The Redo command (or ⇧⌘Z) command does the
opposite, restores again to the edited version exactly as it was just before to
do Undo.
The Undo/Redo engine of DSP-AudioEditor allows an unlimited number of
Undos/Redos: DSP-AudioEditor keeps track of all edits done since it opened
the file – until it saves the audio file.
Please beware that saving an audio file also deletes the Undo/Redo history.
The same happens when quitting the application.
NOTE: each file under editing has its own Undo/Redo history. Doing some
edits on one file, and then switching to a different audio file and doing some
edits on this new file, DSP-AudioEditor starts to save a new Undo/Redo
history. Then, switching back to the previous audio file, its own Undo/Redo
history is safe and it is possible to Undo/Redo last edits done on that file.

Introducing the Real-Time Previewer Controller
For previewing the processed audio, DSP-AudioEditor allows to hear the
result of the edit before deciding whether to apply the changes or not. In this
way it is possible to set the parameters of the algorithm in real time while
hearing the result.
DSP-AudioEditor uses this Real-Time Previewer Controller in several
occasions. Usually it is located on the right side of the dialog used to set the
parameters which are specific to a certain edit function, and appears like
this:

This controller consists of:
The Preset programmer:
On top there is the preset programmer, that manages the preset of the
algorithm.
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If the algorithm allows to store one or more preset, on top there is an active
popup menu which allows to select one of the available preset.
This section allows to set, save and load a preset. A preset is a collection of
all the parameters which are necessary to control the algorithm.
The preview transport bar:
On the bottom part there is the Transport bar, to control the playback of the
audio file.

Transport buttons and the display are very similar to the transport bar used
to control the playback of an audio file under editing. Please refer to the
relevant character for the description of the use of each button and of the
display.
The slider allows to move the playback cursor back and forth in time, along
the audio file.
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The File Menu Commands
Clicking on the File button on top of the waveform view, DSP-AudioEditor
shows a menu with the commands for managing files.
New Audio File
New Empty Audio File (or ⌘N):
to create a new temporary audio file adding it to the Document Manager,

then showing it on a new tab of the waveform Editor view.
New Audio File from Selection:
as above, with the difference that the new audio file is not empty but
contains the samples of the source audio file from the selection start to the
selection end. This command is not available if there is not a waveform
selection.
New Audio File from Clipboard:
to create a new audio file filling it with contents of the current audio
clipboard, then adding this new audio file to the Document Manager, and
showing it on a new tab of the waveform Editor view. This command is not
available if the audio clipboard is empty.
New Audio Files from Markers:
to create new audio files from the list of the generic makers, adding the new
audio files to the to the Document Manager. Each new audio file extends
from one generic marker to the next one on the list. This command is not
available if there are not generic markers.
New Audio Files from Regions:
to create new audio files from the list of the audio regions, adding the new
audio files to the Document Manager. This command is not available if there
are not audio regions.
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New Audio Files from L&R Channels:
to create two new mono audio files, one from the left and one from the right
channels of the current stereo audio file, then adding the new audio files to
the Document Manager. This command is not available if the audio file is
not stereo.
Open Audio File
-

Open … (or ⌃⌘O): to load an audio file from the MacOS file system.
DSP-AudioEditor shows a file browser to select one or more audio files to
open, then adds them to the worksheet, also showing them on the
waveform Editor view.
NOTE: you can select more than one audio file at the same time.
NOTE: DSP-AudioEditor allows to select any audio file in one of the
possible supported format (.aif, .wav. .mp3, .m4a, .caf, ….), then - if
necessary - it takes care to translate the audio file to a un-compressed
PCM audio file, starting to work with it with the maximum audio quality. In
the case in which it is not possible to select an audio file in file browser
because it is greyed-out, it would be necessary to check if that the file
name ends with the proper extension (.wav, .mp3, …).

Import Audio File…

Import Audio File from Dual Mono L&R:
to load a stereo audio file selecting two mono audio files, one for the Left
and one for the Right channels (Dual Mono). This command is useful if you
need to edit in DSP-AudioEditor a stereo audio file generated by an external
application which uses to save a stereo audio file as two -L and -R mono
audio files.
Import Audio File from Binary File:
DSP-AudioEditor is able to import an audio file building it reading a RAW
binary file. It is necessary to enter some parameters used by DSPAudioEditor to translate the binary file to an audio stream to save into a new
audio file.
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DSP-AudioEditor will show a file browser. In the bottom part of this file
browser it possible to set the parameters used to to translate the binary
audio file to a playable audio file:
Bytes Order: when the below Bit Depth parameter is greater than 8 bits/
sample, each sample will use more than one byte. These bytes can be
ordered by following the “Big Endian” standard, generally adopted by the
Motorola microprocessors and PowerPC-based Macs, or “Little Endian”
standard, generally adopted by Intel or Apple Silicon-based Macs and
MSDOS/Windows PCs.

Bit Depth: to set if DSP-AudioEditor must read 8, 16, 24, 32 or 32 (floats)
bits for each sample.
Stereo/Mono: to set the number of interleaved audio channels. For stereo
audio files, DSP-AudioEditor will read one sample to fill the left channel, then
one sample to fill the right channel, and again.
Sample Rate: to set the sample rate that will be adopted for playing the file.
First Sample Offset: to set the offset, expressed in bytes, from the
beginning of the file, that will be used by DSP-AudioEditor before to start to
read samples. This value is very important to skip the audio file header
correctly to realign the audio sample reading position.
Click on the Set button to set the values to the default values to use to read
a binary audio file produced accordingly to the DDP standard.
Save
Save (or ⌘S):
to save the current changes done on the current audio file under editing.
NOTE: DSP-AudioEditor will always ask to save your edits - if any - when it
quits.
NOTE: after saving changes, DSP-AudioEditor will reset the Undo/Redo
history.
Save As…
The sub-menu contains several commands to export the current audio file
converting it using several different audio formats for the destination audio
file.
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Export Audio File As… (or ⌃⌘E):
to export the current audio file to the MacOS file system. DSP-AudioEditor
will show a file browser to type the destination file name, and with a custom

view to set the audio file format to use exporting samples to the destination
file.
The settings on this custom view are:
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Audio File Format: to set among the standard formats which are
available on the list:

-

According to the chosen audio file format, the view which is on the
bottom part of the the file browser changes.
The uncompressed PCM formats (AIFF, WAVE, CAF) need of these
additional parameters:
-

Bits/Sample: DSP-AudioEditor can save 8, 16, 24, 32 or 32 (floats)
bits for each sample. Set “As source” to keep the bit depth of the
source audio file.

-

Stereo/Mono: to set the number of interleaved channels. Set “As
source” to keep the number of channels of the source audio file.

-

Sample Rate: to set the sample rate of the destination audio file. Set
“As source” to use the same sample rate value of the source audio
file.

-

SRC Algorithm Quality: if the sample rate of the destination audio file
is not the same of the source audio file, DSP-AudioEditor will use its
internal Sample Rate Converter (SRC) to write the destination audio
file. Four levels of quality of the advanced liner phase algorithm of
DSP-AudioEditor are available, ranging from Fast to Excellent.

-

Process Fx Plug-in on insert: if ON, DSP-AudioEditor will render the
source audio file using the FX chain on insert on the audio file channel
strip.

-

Add Tail: if the option to process FX is ON, it is possible to add a tail
to the destination audio file, setting also how much this tail must be
long. This is very useful if the FX chain includes an effect like a reverb
or space simulator which produces an additional tail after stopping the
source audio file at its end. Turning ON the option “Add Tail”, DSPAudioEditor will continue to process the audio after reaching the audio
file end, capturing the tail of the effect or of the chain of effects.

-

Apply Fade-Out on Tail: If the options to process FX and to Add Tail
are ON, it is possible to apply a fade-out curve to the tail, avoiding an
abrupt end at the end of the destination file. Turning ON “Apply FadeOut on Tail”, DSP-AudioEditor decreases the output gain while
processing the tail, resulting in a smooth end.
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Export As iTunes Plus AAC:
it is a shortcut to “Export Audio File As…” using the iTunes Plus AAC
standard audio file format for the destination audio file. In this case, no
additional parameters are required.
Export Audio File As .aif:
it is a shortcut to “Export Audio File As…” , setting AIFF as audio file format.
Export Audio File As .wav:
it is a shortcut to “Export Audio File As…” setting WAVE as audio file format.
Export Audio File As .mp3:
it is a shortcut to “Export Audio File As…” setting MPEG Layer 3 (mp3) as
audio file format.
Export Audio File As FLAC:
it is a shortcut to “Export Audio File As…” setting FLAC as audio file format.
Export Audio File As Dual Mono:
given a stereo audio file, saves two mono audio files, one for the Left and
one for the Right channels (Dual Mono), adding a “-L” to the file name of the
first one, a “-R” to the file name of the second one.
Export Selection As…:
calls “Export Audio File As…”, exporting only the region of the selected audio
file waveform. This command is not available if there is not an audio
selection on the waveform view.
Export Selection As iTunes Plus AAC:
calls “Export Selection As…”, but using the iTunes Plus AAC standard audio
file format for the destination audio file. This command is not available if
there is not an audio selection on the waveform view.
Export Loop As…:
calls “Export Audio File As…”, exporting only the region of the Loop. This
command is not available if the Loop is OFF.
Export Markers List to Audio Files:
to export audio files from the list of the generic makers. Destination audio
files will extend from one generic marker to the next one on the list. This
command is not available if there is not any generic marker.
Export Regions List to Audio Files:
to export audio files from the list of the audio regions. This command is not
available if there is not any audio region.
Save All
Save All:
to save all the audio files that have been changed, one after the other.
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Revert
Revert:
to revert changes. DSP-AudioEditor will reload the last saved audio file.
Duplicate Current Audio File
Duplicate Current Audio File… (or ⌃⌘C):
to make a copy of the current audio file, adding this copy to the worksheet,
and showing it on a new tab of the waveform Editor view.
Close
Close:
to close the current audio file under editing. If the file has been changed,
DSP-AudioEditor will ask to save changes, to discard or to cancel the
operation.
NOTE: to click on the left part of the tab on top of the waveform editor view
of a certain audio file is equivalent to use the Close menu command.
Close All
Close All:
to close all the audio files under editing. For each audio file, Iif it has been
changed, DSP-AudioEditor will ask to save changes, to discard or to cancel
the operation.
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The Edit Menu Commands
Clicking on the Edit button on top of the waveform view, DSP-AudioEditor
shows a menu with the commands for doing cut, copy&paste and similar
edits on the audio file:

Cut Editor…
The Cut Editor Tool of DSP-AudioEditor is a very unique graphical tool to
make cut&paste of audio regions without any problem caused by abrupt
changes of the level and slope of waveforms at cut or paste points.
Please refer to the chapter dedicated to the Cut Editor Tool to know more
about it and how to work with it.
Cut…
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Cut (or ⌘X):
to cut the selected region of the audio file. DSP-AudioEditor will also copy
that region into the built-in audio clipboard.
Cut Before:
a shortcut to cut a region of the audio file from the beginning of the audio file
up to a certain point. DSP-AudioEditor allows the following commands:
Cut Before Playback Cursor:
to cut the region of the audio file before the playback cursor. This
command is not available if the playback cursor is at the beginning
of the audio file.
Cut Before Loop Start:
to cut the region of the audio file before the Loop Start. This
command is not available if the loop is OFF or if the Loop starts at
the beginning of the audio file.
Cut Before Selection Start:
to cut the region of the audio file before the of the audio selection
start. This command is not available if there is not a selection or if
the selected audio file waveform starts at the beginning of the audio
file.
Cut After:
similar to the command above, but to cut a region of the audio file from a
certain point up to the audio file end. DSP-AudioEditor allows the following
commands:
Cut After Playback Cursor:
to cut the region of the audio file after the playback cursor. This
command is not available if the playback cursor is at the end of the
audio file.
Cut After Loop End:
to cut the region of the audio file after the Loop End. This command
is not available if the loop is OFF or if the Loop ends at the end of
the audio file.
Cut After Selection End:
to cut the region of the audio file after the the audio selection end.
This command is not available if there is not a selection or if the
selected audio file waveform ends at the end of the audio file.
NOTE: on DSP-AudioEditor Preferences, there is an option to add a certain
number of frames before/after the cut point when applying the Cut Before,
Cut After and Trim (more about the Trim command later in this chapter)
commands. This option is very useful to keep an additional small portion of
waveform before or after the portion of the audio file to keep. Some
softwares or hardware samplers need of some samples after the end loop
point to avoid to click at loop, due their internal interpolation algorithm when
transposing the sample along the keyboard.
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Copy…
Copy (or ⌘C):
to copy a portion or all the audio file into the built-in audio clipboard. If the is
a selection on the waveform view, DSP-AudioEditor will copy only the
selected region. If there is not a selection, DSP-AudioEditor will copy all the
audio file into its audio clipboard.
NOTE: selecting only one channel of a stereo audio file, then doing copy,
DSP-AudioEditor copies only that selected channel into the audio clipboard.
Copy Left into Right Channel:
to copy the left audio channel of the stereo audio file into its right channel,
overwriting it. This command is not available if the audio file is a mono audio
file.
Copy Right into Left Channel:
to copy the right audio channel of the stereo audio file into its left channel,
overwriting it. This command is not available if the audio file is a mono audio
file.
Paste (Insert) and Replace
Paste (or ⌘V):
if there is a selection on the waveform view, this command replaces the
current selection with the current audio clipboard. If there is not a selection
on the waveform view, this command inserts the current audio clipboard at
the position of the playback cursor. In both cases, replacing or inserting,
DSP-AudioEditor places all the audio file clipboard starting at the insertion
point (this insertion point is the selection start when replacing, the playback
cursor when inserting). DSP-AudioEditor also changes the audio file length
accordingly. This command is not available if the audio clipboard is empty.
Replace (or ⌘V):
if there is a selection on the waveform view, this command replaces the
current selection with the current audio clipboard. If there is not a selection
on the waveform view, this command replaces the current audio file, starting
at the position of the playback cursor, with the audio clipboard. This
command is not available if the audio clipboard is empty.
Delete…
Delete (or backspace):
to clear (silencing, as with an eraser tool) the selected waveform or all the
audio file if there is not a selection.
DSP-AudioEditor shows an additional view to set the fade-out and fade-in
times to avoid abrupt changes. There is also a transport bar to preview the
result of deleting.
NOTE: this is a simplified version of the processing function Fade Out<->In,
which is very much more powerful. Please refer to the part of this chapter
describing the Fade Tool to know more about it.
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Insert Silence…

Insert Silence…:
to insert a region of silence (no audio) at playback position.
Then, DSP-AudioEditor shows the above dialog to set length of the region to
insert, in frames and time units.
Append Clipboard…
Append Clipboard…:
to paste the current audio clipboard at the end of the audio file. This
command is not available if the clipboard is empty.
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Trim…

to cut the regions outside a certain region, that is to cut the two regions
which are before and after the region to trim. It is the same as doing two
cuts, one before the region start, one after the region end.
There are two options:
Trim Loop (or ⌥⌘T):
to cut the regions outside the Loop. If the Loop is OFF, this command is not
available.
Trim Selection (or ⌘T):
to cut the regions outside the selection on the waveform view. If the there is
not a selection, this command is not available.
NOTE: the option on Preferences to keep a certain number of samples
doing cuts is used also by the TRIM command.
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The Commands Menu
Clicking on the Commands button on top of the waveform view, DSPAudioEditor shows a menu with various commands, among which the ones
for managing the markers, regions and the Loop of the audio file:

Rebuild Graphic Overview…
Doing edits as cut, copy, insert and similar operations, DSP-AudioEditor
rebuilds the waveform overview using a very fast algorithm. This method
can, after several cuts or pastes, cause a small approximation on the time xaxis alignment of the displayed waveform. In this case, the waveform can
appear out of sync of some pixels when zoomed-out. Use this command to
fix the situation rebuilding the whole waveform overview. If the file is very
long, it requests some seconds to complete but, after this, the overview is
again perfectly aligned.
NOTE: it is recommended to use this command every 20-30 operations of
cut, copy, insert or similar.
Zoom…
Clicking on zoom opens a sub menu with zoom commands to zoom in/out
on both X and Y axis.
X-Axis Zoom In (or +):
to zoom-in the waveform view on the X-Axis by a factor x2.
X-Axis Zoom Out (or -):
to zoom-out the waveform view on the X-Axis by a factor x2.
X-Axis Full Zoom In:
to full zoom-in the waveform view on the X-Axis.
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X-Axis Full Zoom Out:
to full zoom-out the waveform view on the X-Axis.
Y-Axis Zoom In (or ⌘+):
to zoom-in the waveform view on the Y-Axis by a factor x2.
Y-Axis Zoom Out (or ⌘-):
to zoom-out the waveform view on the Y-Axis by a factor x2.
Y-Axis Full Zoom Out:
to full zoom-out the waveform view on the Y-Axis.
XY-Axis Full Zoom Out:
to full zoom-out the waveform view on both the Y and X Axis.
Fit on Selection (or ⌘=):
to zoom-in or zoom-out on the Y-Axis the waveform view such to make
visible the current waveform selection. This command is not available if
there is not a waveform selection.
Fit on Loop:
to zoom-in or zoom-out the waveform view on the Y-Axis such to make
visible the Loop. This command is not available if the Loop is OFF.
NOTE: It is possible to use the mouse wheel to Zoom In/Out on the X-Axis.
The same can be done moving vertically 2 fingers on the Apple Trackpad, if
any. Use ⌘ + mouse wheel to set the vertical Y-Axis zoom-in/out ratio.
Playback Cursor…
Clicking on Playback Cursor opens a sub menu with the commands to place
the playback cursor (RED marker on the waveform view) on specific
positions.
Please refer to the previous chapter about Working with Markers for a full
reference of this menu commands.
Generic Markers…
Clicking on Generic Markers opens a sub menu with the commands to
manage the Generic markers.
Please refer to the previous chapter about Working with Markers for a full
reference of this menu commands.
Regions…
Clicking on Regions opens a sub menu with the commands to manage the
audio regions of the audio file.
Please refer to the previous chapter about Working with Markers for a full
reference of this menu commands.
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Turn Loop ON/OFF… (or ⌘L)
To toggle the Loop ON and OFF. If the Loop has been turned ON, the two
Loop markers (the yellow markers) will appear on the waveform view.
Otherwise, DSP-AudioEditor will hide them.
See also the previous chapter about Working with the Loop.
Lock Loop Length… (or ⌥⇧⌘L)
To lock/unlock the length of the Loop. If the Loop length is locked, moving
any one of the two Loop markers, the other one will move accordingly. This
option is useful in the case that, once you have found a good Loop, you wish
to shift the Loop without changing its length. This command is not available if
the Loop is OFF
See also the previous chapter about Working with the Loop.
to place the Loop markers at the current selection start and end. (This
command is not available if there is not a selection on the waveform view). If
the Loop is turned Off, it will automatically be turned On.
More about this in the previous chapter about Working with the Loop.
Show/Hide Loop Window (or ⌥⌘L):
to show or hide the Loop floating window tool.
More about this in the previous chapter about Working with the Loop.
Select All…
To select all the audio file on the waveform view.
Select Loop…
To select the Loop on the waveform view. This command is not available if
the Loop is OFF.
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The Processing Menu
Clicking on the Processing button on top of the waveform view, DSPAudioEditor shows a menu with the commands for processing the audio file:

AU Plug-in…
Clicking on this menu item will open a sub menu on which DSP-AudioEditor
lists all Audio Unit (AU) plug-ins installed on MacOS, grouped by
manufacturers.
DSP-AudioEditor asks to MacOS the list of the installed plug-ins. To be
visible, the AU plug-in must be a 64 bits effect plug-in.
Selecting one of the available plug-ins, DSP-AudioEditor opens a dialog
displaying the custom interface of the AU plug-in (it depends on the plug-in
itself) on the left part and, on the right, a preview controller to manage the
plug-in preset and with a transport bar to preview the result before to apply
it. DSP-AudioEditor will automatically resize the dialog accordingly to the
plug-in custom view.
As an example, this is the dialog which DSP-AudioEditor shows loading the
Apple Multiband Compressor plug-in which is built-in and available for free in
MacOS:

55

NOTE: it is highly recommended to explore the excellent Apple AU plug-ins
which are always present because built-in into MacOS. They offer an
excellent quality for free.
NOTE: If there is a selection on the waveform view, the function will process
only the selected region, otherwise all the audio file.
Please refer to the previous chapter about the real time preview controller to
know how to use it for loading/saving the current plug-in preset and for
previewing the processed audio.
Render Insert FX…
Using DSP-AudioEditor is possible to load a serial chain of effect plug-ins on
insert to the channel strip of the audio editor, which is different for each
audio file under editing. Use this command to render this serial chain of
effect plug-ins into a new audio file. The result is the same as playing the
current audio file thru the effects chain and then saving the result into a new
file which DSP-AudioEditor loads automatically on the Document Manager
and - optionally - opens into a new tab of the waveform Editor view.
Clicking on this menu command, DSP-AudioEditor shows a dialog to set the
parameters for rendering the plug-ins loaded on the channel strip into a new
audio file:
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New File Name:
type the new file name.
Load it on the Audio File Editor:
if turned ON, DSP-AudioEditor, after processing and loading the new
processed audio file into the Document Manager, opens the new file into a
new tab of the waveform Editor view.
Add Tail:
It is possible to add a tail to the destination audio file, setting also how much
this tail must be long. This is very useful if the FX chain includes an effect
like a reverb or space simulator which produces an additional tail after
stopping the source audio file at its end. Turning ON the option “Add Tail”,
DSP-AudioEditor will continue to process the audio after reaching the audio
file end, capturing the tail of the effect or of the chain of effects.
Apply Fade-Out on Tail:
If the option to Add Tail is ON, it is possible to apply a fade-out curve to the
tail, avoiding an abrupt end at the end of the destination file. Turning ON
“Apply Fade-Out on Tail”, DSP-AudioEditor decreases the output gain while
processing the tail, resulting in a smooth end.
Digital Effects…
DSP-AudioEditor has several high quality digital effects which are built-in
into the application itself. They can be seen as custom plug-in which are
unique to DSP-AudioEditor.

NOTE: If there is a selection on the waveform view, the function will process
only the selected region, otherwise all the audio file.
This group of effects includes the effects using modulated delay lines and
chamber/hall simulations: Chorus, Stereoizer, Delay, Dual Delay, Multitap
Delay, Reverbs 1&2.
More about using these effects in the chapter about Using the built-in Effects
of DSP-AudioEditor.
Digital Filters…
This group of effects includes the digital filters: Parametric & Graphic
Equaliser, Resonant filters (Analog Filter Emulators).
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More about using these effects in the chapter about Using the built-in Effects
of DSP-AudioEditor which is later in this manual.

Find Peak&RMS…

This command opens a dialog on which DSP-AudioEditor shows the Peak
and RMS level computed on the audio file. If there is a waveform selection
on the waveform view, DSP-AudioEditor shows the Peak and RMS level
computed only on the selected region.
DSP-AudioEditor shows also the number of clips, defined as the points
where the waveform reaches the maximum values of –1.0 or 1.0, and the
ratio between the number of clips and the number of frames of the audio file.
It is also possible to add a generic marker at the position of the detected
peak (or at the position of the first clip, if there are more audio clips). If you
want to add a marker, turn ON the check box.
Detect BPM…
This menu item opens a sub menu on which you can choose the region
used by DSP-AudioEditor to calculate the Beats Per Minute (BPM).
These are the different options:
Use All
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DSP-AudioEditor calculates the Beats Per Minute (BPM) using all the audio
file length.
Use Selection
DSP-AudioEditor calculates the Beats Per Minute (BPM) using the length of
the selection on the waveform view. This command is not available if there is
not a selection.
Use Loop
DSP-AudioEditor calculates the Beats Per Minute (BPM) using the length of
the Loop. This command is not available if Loop is OFF.
DSP-AudioEditor shows the following dialog:

To calculate the BPM value, it is necessary to enter:
- Beats/Measures: number of Beats for each Measure. This is the number
of metronome hits. As an example, in case of a time signature of 3/4, it is
equal to 3.
- Additional Beats: it is the rest of Beats.
- Num Of Measures: it is the total number of measures.
For example, in case we want to know the BPM from a region equal to 3
measures in 4/4, plus one in 3/4, we need to set:
Beats/Measures
Additional Beats
Num of Measures

=4
=3
=3

- BPM shows the calculated result. When one of the values in the upper part
changes, the value of the BPMs updates in real time accordingly.
- Set As Master Clock BPM Value: check this flag to set the calculated
BPM value as Master BPM Tempo value. It is the master clock use by DSPAudioEditor as reference for sending the sync message to AU plug-ins,
effects.
MonoToStereo
Given a mono audio file, this command change it to a stereo file duplicating
the single audio channel.
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This command is not available if the audio file is stereo.
StereoToMono
Given a stereo audio file, this command change it to a mono file mixing the
left and right channels into a single audio channel. The source left and right
channels will be gained by a factor x0.5 before mixing to avoid clipping.
This command is not available if the audio file is mono.
Remove DC…
To subtract (remove) the DC Level from an audio file.
The DC Level of an audio file is the average value of all samples. The
waveform that represents the audio file should oscillate around the zero, and
therefore its average value should be zero. But it can happen that the
waveform oscillate around a value (DC) which is not the zero level. This can
be caused by, for example, a bias current in the analog circuit of the Analog
To Digital (A/D) converter used for sampling the signal.
If there is a selection, this function process only the selected region,
otherwise all the file.
Invert…
To invert the audio signal around the zero level, ie to change the sign of all
the samples in the region to edit.
If there is a selection, this function process only the selected region,
otherwise all the file.
Reverse…
To reverse in time the audio signal of the audio file, playing it on reverse,
from the end to the beginning.
If there is a selection, this function process only the selected region,
otherwise all the file.
Swap L&R Channels…
To swap the samples between left and right channels of a stereo audio file.
If there is a selection, this function process only the selected region,
otherwise all the file.
Normalize… (or ⌘G)
To apply an automatic linear gain to samples of the audio file such that the
level of maximum peak of the processed audio file will be equal to 0 dB.
NOTE: this is one the most used editing function. Doing a recording, usually
it is safer to keep the recording level low enough to avoid audio clips at 0 dB,
which would cause a distortion. Then it is a good practice to apply this edit
function to bring the level of the signal to the maximum allowed level.
If there is a selection, this function process only the selected region,
otherwise all the file.
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Normalize To… (or ⌥⌘G)
as the above Normalize processing function, with the difference that the
target maximum peak of the processed audio file is a user programmable
value.
Then, DSP-AudioEditor shows a dialog where:

On the right side, there are the results of the analysis of the region of the
audio file to process. These results are the same as seen running the Find
Peak&RMS command.
On the left a slider to set the target for the peak of the audio file after
processing.
If there is a selection, this function process only the selected region,
otherwise all the file.
Apply Gain…
This command opens the Fade Editor Tool setting the Fade Type to Gain
by default.
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The Fade Editor is a graphical tool used to apply a gain on a certain region
defining also user programmable curves for the fade-in and fade-out for
smoothing the gain changes.
Please refer to the chapter describing the Fade Editor Tool to know more
about how to use it.
If there is a selection, this function process only the selected region,
otherwise all the file.
Fade In… (or ⇧⌘F)
To apply a linear fade-in gain curve to the region to process. The level of the
processed audio file will start from zero at region start to reach the full level
at region end.
If there is a selection, this function process only the selected region,
otherwise all the file.
NOTE: this is a fast shortcut to fade-in a certain region, without any
graphical tool. For more complex edits, it is possible to use the Fade Editor
Tool. Please refer to the chapter describing the Fade Editor Tool to know
more about how to use it.
Fade Out… (or ⇧⌘F)
To apply a linear fade-out gain curve to the region to process. The level of
the processed audio file will start from the full level at region start to reach
the zero at the region end.
If there is a selection, this function process only the selected region,
otherwise all the file.
NOTE: this is a fast shortcut to fade-out a certain region, without any
graphical tool. For more complex edits, it is possible to use the Fade Editor
Tool. Please refer to the chapter describing the Fade Editor Tool to know
more about how to use it.
Fade In<->Out… (or ⌥⌘F)
This command opens the Fade Editor Tool setting the Fade Type to Fade
In-Out by default.
If there is a selection, this function process only the selected region,
otherwise all the file.
Please refer to the chapter describing the Fade Editor Tool to know more
about how to use it.
Fade Out<->In…
This command opens the Fade Editor Tool setting the Fade Type to Silence
by default.
If there is a selection, this function process only the selected region,
otherwise all the file.
Please refer to the chapter describing the Fade Editor Tool to know more
about how to use it.
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X-Fade Looping… (or ^⌘L)
-

This command opens the X-Fade Looping Editor.

The X-Fade Looping Editor is a graphical tool used to apply a X-Fade
looping algorithm to the Loop region. It is possible to define the shape of the
X-Fade curves, checking visually what happens to the processed audio file,
previewing the waveform and listening to the result as well.

Please refer to the chapter describing the X-Fade Looping Editor to know
more about how to use it.
Loop by BPM…

To set the Start and End Loop points such that its length is calculated from
the value expressed as Beats Per Measures (BPM). It is also possible to set
if the Loop must start at the beginning of the audio file, at the playback
cursor, or if it must end at the end of the audio file.
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NOTE: This is a very useful function when you want to set a Loop on
rhythmic patterns. In this case the length of the Loop has to be based
considering the Beats Per Measures metronomic tempo.
It is necessary to set the following parameters:
- BPM: it is the value of the target Beats Per Measures (BPM)
- Beats/Measures: number of Beats for each Measure. This is the number
of metronome hits. As an example, in case of a time signature of 3/4, it is
equal to 3.
- Additional Beats: it is the rest of Beats.
- Measures: it is the total number of measures.
As an example, in case we want to position the Loop points on a region
equal to 3 measures in 4/4, plus one more in 3/4, with a BPM time of 120.32,
we must set:
BPM
Beats/Measures
Measures
Add. Beats

= 120.32
=4
=3
=3

It is also necessary to set where the Loop must start:
-

Loop At Playback : the Loop starts at the playback cursor

-

Loop At Start : the Loop starts at the beginning of the audio file

-

Before End : the Loop ends at the end of the audio file

If the Loop was OFF, DSP-AudioEditor also turns it ON automatically.
Resample… (or ⌥⌘R)
To change the sample rate of the audio file by using a HQ linear phase
Sample Rate Converter (SRC) algorithm of DSP-AudioEditor.
The Nyquist theorem demonstrates that the maximum frequency which can
be reconstructed from a digital audio signal is the half of its sample rate. For
this, lowering the sample rate, the SRC algorithm must also remove the
highest frequencies components to guarantee that the maximum frequency
of the digital audio signal is lower than the half of its sample rate. This will
lower the audio spectrum range of the audio signal. The benefit is that the
audio file will have smaller dimensions, saving space on the hard disk.
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NOTE: the offline Sample Rate Converter (SRC) algorithm of DSPAudioEditor uses a very High Quality Linear Phase Sample Rate
Converter (SRC) Resampling algorithm, based on the state-of-art
technology about the Digital Signal Processing and linear phase digital
filtering. This SRC guarantees the maximum audio quality, in terms of
frequency response and audio quality (the filter characteristic is outstanding
and being Linear Phase, the algorithm does not introduce phase inversion at
the transition band).
-

New Sample Rate: to set the sample rate of the processed audio file. It
is possible to choose one of the most common values on the popup
menu or to enter the new value numerically.

-

SRC Algorithm Quality: to set the quality of the offline Sample Rate
Converter (SRC) algorithm. The Excellent quality needs more CPU time
than the others. It will produce the result with the maximum quality but
will be slower to complete the process. Possible values are Fast, Good,
Better, Excellent.

Speed&Pitch Change…
To change the pitch of the audio file playing it faster (to rise the pitch) or
slower (to lower the pitch). This is equivalent to modify the speed of a tape
recorder. Also the length of the audio file will change accordingly. Playing it
faster, it will take less time to reach the end, producing a shorter audio file,
the opposite playing it slower.
DSP-AudioEditor shows the following dialog:

-

Ratio: to set the ratio between the pitch of the processed audio file and
the source as a float value (ratio = 1.0 means no change, ratio = 2.0
means an octave up, and so on).

-

Semitones: to set the ratio between the pitch of the processed audio file
and the source as semitones (semitones = 0.0 means no change,
semitones = +12.0 means an octave up, and so on).
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If there is a selection, this function process only the selected region,
otherwise all the file.
NOTE: It is also possible to modify the pitch without change the speed - or
time (duration of the audio file), using the Pitch Shifting command of DSPAudioEditor.
Pitch Shifting…
To change the pitch of the audio file without changing the speed (duration of
the audio file). This algorithm does not modify the time - length - of the audio
file.
DSP-AudioEditor shows the following dialog:

As for the Speed&Pitch Change command,
-

Ratio: to set the ratio between the pitch of the processed audio file and
the source as a float value (ratio = 1.0 means no change, ratio = 2.0
means an octave up, and so on).

-

Semitones: to set the ratio between the pitch of the processed audio file
and the source as semitones (semitones = 0.0 means no change,
semitones = +12.0 means an octave up, and so on).

If there is a selection, this function process only the selected region,
otherwise all the file.
NOTE: To achieve the result, DSP-AudioEditor uses a very High Quality
Spectral Re-Synthesizer, which is a very sophisticated algorithm compared
to the algorithm used for Speed&Pitch Change.
Time Stretching…
To change the speed (time) of the audio file without changing the pitch.
DSP-AudioEditor shows the following dialog:
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There are different options to set the ratio between the length of the
destination and of the source file:
- Ratio: it is possible to set the ratio using the slider on the left, or using the
numerical control above the slider as well.
- Destination Length: it is possible to enter directly the length of the
destination audio file, expressing it as total number of frames or as total
time.
- Destination BPM: it is also possible to set the ratio expressing it as Beats
Per Minutes (BPM), which is a more usual form used by musician. For this,
first it is necessary to set the BPM of the source file, clicking on the SET
button in the section related to the parameters of the source file. This opens
a dialog that allows you to set all the parameters needed to compute the
source BPM, as previously described for the Detect BPM command. Then,
use the numerical control to set the destination BPM in the section related to
the parameters of destination file. DSP-AudioEditor will automatically set the
time stretching ratio.
If there is a selection, this function process only the selected region,
otherwise all the file.
NOTE: DSP-AudioEditor uses an High Quality Spectral Re-Synthesizer
doing Time Stretching.
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The Cut Editor Tool
DSP-AudioEditor offers a very unique Cut Graphic Editor tool to make cuts
on the audio file, as well as pastes of the clipboard into an audio file, without
any problem caused by possible abrupt changes in the level and slope of
waveforms at cut or paste points.

Doing a graphical Cut using the Cut Editor Tool
To start using the Cut Editor, click on the Edit button on top of the waveform
view, and select Cut Editor, DSP-AudioEditor shows a submenu with the
commands for opening the Cut Editor:

Cut… (or ⇧⌘X):
DSP-AudioEditor opens the Cut Editor to do a cut at playback position:
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In the upper part, to the left, there is the waveform before the cut point. In
the lower part, to the right, there is the waveform after the cut point.
Click on the waveform on the right, that’s the audio file region after the cut
point, and drag it to the left such to overlap the waveform in the upper part,
that’s the region before the cut point. DSP-AudioEditor will automatically
create a cross-fade curve between the two overlapping regions:

Setting fade-In/Out lengths and shapes of the curve
The Cut Editor Tool gives the complete freedom for setting the cross-fade
lengths and the shape of the fade-in/out curves. Fade-In length and curve is
independent from Fade-Out length and curve, if necessary.
To set the length only of the fade-out of the upper waveform, click with the
mouse on the little yellow circle control at the beginning of the fade-out, and
shift it backward or forward along the time axis. Do the same procedure to
set the fade-in length of the lower waveform, that’s the audio file region after
the cut point.
To set the shape of the curve of the fade-out, click on the little circle control
in the middle of the fade-out curve, and drag it to the four directions setting
the slope which best suite your needs. Do the same to set the shape of the
curve of the fade-in of the waveform after the cut point.
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DSP-AudioEditor allows two different types of shapes for the Fade-In/Out
curve:
-

Exponential/Bezier type: in this case the shape control point can move
on all directions, setting all the shapes ranging from logarithmic, linear,
exponential.

-

S-Curve type: in this case the shape control point can move only up or
down, the shape is convex or concave according to the vertical position
of the shape control point.

To set the type of the shape, click with the right mouse button on the shape
control point, DSP-AudioEditor will show an utility popup menu with the
command:

NOTE: by default, the shape of each curve is independent. Keeping the
SHIFT key pressed while clicking and dragging the control to set the shape
of a the fade-In or fade-Out curve, then also the other fade curve will follow
such that the sum of the gain of the two curves is always constant (equal
power).
Trimming the the start and end of the region at cut point
Moving the mouse to the border of the upper waveform or of the bottom
waveform, the mouse mode will change to the Trimmer:
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In this mode, clicking and dragging the mouse to the left or to the right, DSPAudioEditor trims the region end (trimming the waveform before the cut
point) or region start (trimming the waveform after the cut point).

Inserting the Clipboard or Replacing with the Clipboard using the Cut
Editor Tool
On the Cut Editor sub menu, if the Audio clipboard if DSP-AudioEditor is not
empty, these other commands are also available:
Insert… (or ⇧⌘V):
DSP-AudioEditor opens the Cut Editor, do the cut at playback position, and
inserts the clipboard at the position of the cut. In the upper part, to the left,
there is the waveform before the cut point. In the lower part, in the middle,
there is the waveform of the audio clipboard then, again in the upper part,
there is the waveform starting just after the cut point.
Replace… (or ⇧⌘Y):
DSP-AudioEditor opens the Cut Editor, do the cut at playback position, and
places the clipboard at the position of the cut. In the upper part, to the left,
there is the waveform before the cut point. In the lower part, in the middle,
there is the waveform of the audio clipboard then, again in the upper part,
there is the source audio file waveform without the presence of the clipboard
in between.
The difference between Inserting and Replacing is that in the first case DSPAudioEditor makes the space to place the clipboard at cut position, shifting
the rest of the source audio file forward along the time axis. In the second
case it keeps in sync the last section of the source audio file, without shifting
it along the time axis.

Also in this case, it is possible to shift the waveforms of the clipboard and of
the region after the cut along the time axis. It is possible to set the fade-in/
out length as set the fade-in/out curve shapes as well.

Using the scissor mode to make additional cuts
The Cut Editor allows to make additional cuts and cross-fades, if needed.
Clicking on the scissor button positioned to the bottom of the waveform view:
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The mouse pointer will change to a scissor. Then, clicking on the waveform
view, the Cut Editor splits the audio file exactly on that position, moving the
waveform which follow the cut point on the other side of the view. It is
possible to repeat the operation as many times as necessary.

To return to be able to shift the waveforms on the waveform view, click on
the shifter button which is positioned to the right of the scissor button.
Zooming In/Out is possible as well. Use the mouse wheel, the keyboard or
the buttons on the lower right part of the Cut Editor for zooming.
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The Fade Editor Tool
The commands ApplyGain…, FadeIn<->Out… and FadeOut<->In…,
available on the Processing menu, use the same Fade Editor tool window:

On the left part, the Fade Editor shows the graphical representation of the
envelope curve composed by a Fade-In, a Gain level and a Fade-Out. It is
possible to set the length as well as the shapes of the FadeIn/Out curves
clicking and dragging the fade yellow circular controls.
On the right part, the Fade Editor shows sliders and editable fields to enter
the fades and gain values numerically.
On the upper right part of the the Fade Editor, the possible settings of the
Fade Types are:
-

Fade In-Out (automatically set by calling the FadeIn<->Out…
command): in this case the envelope curve starts at zero gain (-inf dB), to
fade-in reaching the Gain level, then fades-out to reach the zero level at
the end.

-

Gain (automatically set by calling the ChangeGain… command): in this
case the envelope curve starts at +0dB level (no level change on the
source file), fades to the Gain value, then fades to reach again the +0dB
at the end. Use this option to change the gain of the source audio file
without changing the audio levels at the borders.

-

Silence (automatically set by calling the FadeOut<->In… command):
starts at +0dB level (no change of level on the source file), fades to the 0
level (silence), then fades again to +0dB. It is similar to Gain where the
Gain level is at zero (-inf dB).

NOTE: by default, if the file is stereo, the envelope curve processes both the
L&R channels. It is possible to process only one channel turning OFF the
channel to keep as it is, clicking on the L or R square buttons below the
waveform view, in the right part to the Fade Editor window.
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The X-Fade Looping Editor Tool
The X-Fade Looping Editor is a graphical tool used to apply a X-Fade
looping algorithm to the Loop region. It is possible to define the shape of the
X-Fade curves checking in real time what happens to the processed audio
file visually, previewing the waveform and listening to the result as well.

The X-Fade Looping algorithm, available only if the Loop is turned On,
modifies the samples into the loop region mixing the region before the Loop
Start with the region before the Loop End, applying a cross-fade (X-Fade)
between the samples to copy and the samples already on that region.

74

The purpose to make the loop which plays as much as natural and as
smooth as possible. Because, applying the X-Fade looping, the sample at
the Loop End will be mathematically identical to the one at the Loop Start,
there is not any abrupt change or audio click when playing and jumping from
the loop end to the loop start. But it can happen that the result is not musical.
The success of the operation depends on several factors:
- before to apply the X-Fade, the loop points must be already positioned in
places considered good for looping, even if the audio clicks at loop.
- The length of the X-Fade is a very important factor to achieve an
acceptable result, and it is difficult to give in advance a precise rule about
the best value to set. Generally, when applying the X-Fading Loop algorithm
to short loops (less than 1 sec), it is recommended to enter high length
values for the X-Fade, even equal to the full loop length. Instead, in case of
long loops, smaller values for the X-Fade length are generally very much
more appropriate.
The maximum value for the X-Fade length cannot never exceed the length
of the loop, and it cannot exceed also the position of the loop start marker
respect the beginning of the file. In other words, the maximum length of the
X-Fade is smallest value between the length of the loop and the position of
the loop start marker.
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The Built-in Effects of DSP-AudioEditor
DSP-AudioEditor has a series of built-in digital effects of very high quality.
they range from the various uses of modulated digital delay lines, to the
simulation of analog filters and bank of filters. Algorithms for the room and
hall simulations are available as well.
It is possible to use the built-in effects of DSP-AudioEditor in the same way
as all the other Audio Unit (AU) Effect plug-ins installed on MacOS.
Using an effect as edit function in the Audio Editor, the function modifies only
on the selected region if there is a selection, otherwise all the audio file.
Among these different effects, there are several shared graphic objects,
such as knobs, sliders, and Vu-Meters.
This chapter describes in detail all their characteristics.
The DSP-AudioEditor built-in effects can be grouped into two main
categories:
- Digital Effects: these are the effects using modulated delay lines and
room/hall simulations (Delay, Chorus, Reverb)
- Digital Filters: these are the effects using digital filters (Parametric &
Graphic Equalizer, Analog Filter Emulators).
- Tools: there are special plug-ins. One is a Gainer/Phase Inverter, one is a
very special Send&Returns to/from the hardware audio device. More about
this later in this chapter.
As in the case of the other AU Effect plug-ins, these effects can be used as
real time effects, loading them on insert on the channel strip, or can be used
for processing as any other edit function, calling them on Processing menus.
Chorus
The chorus algorithm uses dual delay lines, modulated by a Low Frequency
Oscillator (LFO).

- L&R Gain Sliders: on the left there is a section with two gain sliders, one
for the Left, one for Right channel. Use these sliders to control the gain of
the input signal. Peak and RMS Vu-Meters show the input L&R signal levels.
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- Efx Balance [0.0...1.0]: to set the ratio between the processed and the
input audio signals.
- Delay [0.0...30.0 msecs]: to set the delay time used by the algorithm.
Higher values produce a more noticeable and deep chorusing.
- LFO Depth [0.0...1.0]: to set the amount of the modulation of the delay
time by the LFO (Low Frequency Oscillator). Higher values produce more
noticeable and deep chorusing.
- LFO Rate [0.0...5.0 Hz]: to set the speed of the LFO. Lower values
produce a lighter and less intrusive effect.
Stereoizer
The Stereoizer effect uses pass-band filters to enhance the stereo image of
the input signal.
NOTE: it is highly recommended to check the mono compatibility of the
signal on output, due to phase cancellation side-effect when summing the
Left and Right channel if listening in mono.

- L&R Gain Sliders: on the left there is a section with two gain sliders, one
for the Left, one for Right channel. Use these sliders to control the gain of
the input signal. Peak and RMS Vu-Meters show the input L&R signal levels.
- Depth [0.0..1.0]: to set the depth of the effect.
Delay
Using one or more Delay effects it is possible to create very special mono
and stereo echoes.
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The Delay effect of DSP-AudioEditor is a single delay line, which mixes the
L&R input channels before to process the signal into a delay line. It is very
good to simulate the vintage sound of delay pedals used mostly by
guitarists.
-

L&R Gain Sliders: on the left there is a section with two gain sliders, one
for the Left, one for Right channel. Use these sliders to control the gain of
the input signal. Peak and RMS Vu-Meters show the input L&R signal
levels.

-

Efx Balance [0.0...1.0]: to set the ratio between the processed and the
input audio signals.

-

Time [0..2000 msec]: to set the time of the delay line, in msec. and in
BPM (Beats Per Minute). Changing one of the values, DSP-AudioEditor
will automatically change the other one in real time as well.

-

Feedback Level [0.0..1.0]: set the feedback level of the output signal
back to the input. The feedback level changes the number of repetitions
(echoes) of the effect.

-

Feedback Filter Cutoff [20..16000 Hz]: the feedback line is processed
by a lowpass filter to emulate the absorption of reflecting materials, which
higher for the high frequencies.

Dual Delay
The Dual Delay effect of DSP-AudioEditor uses two independent delay lines,
one for the left and one for the right channel. It is very good to produce pingpong stereo effects and to spread the stereo image of a stereo input signal.

-

L&R Gain Sliders: on the left there is a section with two gain sliders, one
for the Left, one for Right channel. Use these sliders to control the gain of
the input signal. Peak and RMS Vu-Meters show the input L&R signal
levels.

-

Efx Balance [0.0...1.0]: to set the ratio between the processed and the
input audio signals.

For each delay line:
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-

Time [0..2000 msec]: to set the time of the delay line, in msec. and in
BPM (Beats Per Minute). Changing one of the values, DSP-AudioEditor
will automatically change the other one in real time as well.

-

Feedback Level [0.0..1.0]: set the feedback level of the output signal
back to the input. The feedback level changes the number of repetitions
(echoes) of the effect.

-

Feedback Filter Cutoff [20..16000 Hz]: the feedback line is processed
by a lowpass filter to emulate the absorption of reflecting materials, which
higher for the high frequencies.

MultiTap Delay
The MultiTap Delay effect is uses four independent delay line, each with its
own controls for setting its level and pan-pot on output signal.

-

L&R Gain Sliders: on the left there is a section with two gain sliders, one
for the Left, one for Right channel. Use these sliders to control the gain of
the input signal. Peak and RMS Vu-Meters show the input L&R signal
levels.

-

Efx Balance [0.0...1.0]: to set the ratio between the processed and the
input audio signals.

For each delay line:
-

Time [0..2000 msec]: to set the time of the delay line, in msec. and in
BPM (Beats Per Minute). Changing one of the values, DSP-AudioEditor
will automatically change the other in real time as well.

-

Feedback Level [0.0..1.0]: set the feedback level of the output signal
back to the input. The feedback level changes the number of repetitions
(echoes) of the effect.

-

Feedback HF Dump [20..16000 Hz]: the feedback line is processed by a
lowpass filter to emulate the absorption of reflecting materials, which
higher for the high frequencies.

-

Panpot [-64..0..64]: to set the balance between L&R channels of the
output signal of each delay line. -1.0 means full to the Left channel, 0
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means equally balanced between L&R channels, and +1.0 full to the R
channel.
-

Level [0.0..1.0]: sets the level of the output signal from each Delay unit.

Reverb 1 and Reverb 2
There are two reverb effects in DSP-AudioEditor. They differ from one each
other for their internal algorithm. The first one is more intense, the second is
lighter. Depending on the audio file that you are working with, one could be
more suitable than the other.

-

L&R Gain Sliders: on the left there is a section with two gain sliders, one
for the Left, one for Right channel. Use these sliders to control the gain of
the input signal. Peak and RMS Vu-Meters show the input L&R signal
levels.

-

Efx Balance [0.0...1.0]: to set the ratio between the processed and the
input audio signals.

-

Time [0.0..1.0]: to set the reverb time. This value is expressed as the
ratio between the minimum value (time = 0) and the higher possible value
(time=1.0).

-

Absorption [0.0...1.0]: to set the factor which emulates the reflecting
properties of the walls in function of the frequency spectrum. Lower
values correspond to materials having an higher absorption at high
frequencies.

-

PreDelay [0...100 msec]: to set the time of the delay line on input to the
reverb effect. It simulates the time that it takes the first echo to be heard
due to the distance of the reflecting surface as it happens, as an
example, when playing in a church or a very large hall.

Parametric EQ
The Parametric EQ of DSP-AudioEditor has six full parametric filters.
It is possible to set the frequency, gain, and bandwidth (Q) of each filter.
Since all the filters have a full excursion on the frequency range, it is
possible to overlap two or more filters, to let them to work on the same
frequency range.
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-

L&R Gain Sliders: on the left there is a section with two gain sliders, one
for the Left, one for Right channel. Use these sliders to control the gain of
the input signal. Peak and RMS Vu-Meters show the input L&R signal
levels.

-

Reset: to reset each parametric filter to the default values.

For each parametric filter:
-

Gain [-18..+18 dB]: to set the gain of the parametric filter.

-

Freq [20..16000 Hz]: to set the central frequency of the frequency band.

-

Q [0.0..5.0]: it controls the width of the frequency response curve of the
filter. Higher values correspond steeper curves, ie a more selective filter.

Graphic EQ

The graphic equalizer of DSP-AudioEditor built-in uses a bank of seven
filters to modify the frequency contents of the audio signal. Each filter is
centered around a different frequency according to a logarithmic scale. It is
possible to set the gain of each filter in the ±18 dB range.
- L&R Gain Sliders: on the left there is a section with two gain sliders, one
for the Left, one for Right channel. Use these sliders to control the gain of
the input signal. Peak and RMS Vu-Meters show the input L&R signal
levels.
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-

Reset: to reset all gains to 0 dB.

-

Gain [-18...+18 dB]: to set the gain of each frequency band. It is also
possible to enter the numerical value clicking on the control below the
slider.

-

Link L&R: when turned On, setting a gain value for one channel, will set
the same value for the other channel as well.

Resonant LowPass, BandPass, HighPass and BandReject Analog Filter emulations
Among the effects of DSP-AudioEditor, there are the filters that simulate the
resonant analog filters, that became famous in the music world during the
’70s, in vintage analog synthesizers. The following analog resonant filters
are available: LowPass, HighPass, BandPass and Notch.

Each filter uses its own interface that is however very similar to the other.
You can set the cutoff frequency, the resonance at cutoff frequency – called
Resonance for LowPass and HighPass, or Q in the other cases – and the
slope of the curve, measured in -dB/octave. Higher slopes bring to more
selective filters, that are more resonant and that cut frequencies with steeper
curves.
-

L&R Gain Sliders: on the left there is a section with two gain sliders, one
for the Left, one for Right channel. Use these sliders to control the gain of
the input signal. Peak and RMS Vu-Meters show the input L&R signal
levels.

-

Shape: to choose among one of the following:
• Resonant LowPass: it cuts all frequencies above the cutoff frequency.
Slope can be set to -12 or -24 dB/Octave.
• Resonant BandPass 1: it cuts the frequencies outside the band
centered around the cutoff frequency.
• Resonant BandPass 2: similar to BandPass 1, but a lot more resonant.
• Resonant HighPass: it cuts all frequencies below the cutoff frequency.
Slope can be set to -12 o -24 dB/Octave.
• BandReject: it cuts the frequencies in the band just around the cutoff
frequency. It can be very selective with high values of Q, and is very
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useful when you want to remove from the audio signal a specific
frequency, such as the power line noise at 50 o 60 Hz.
-

Slope: to set the slope (-12 or -24 dB) of the filter.

-

Frequency [20..16000 Hz]: to set the value of cutoff frequency.

-

Resonance/Q: to set the resonance value or the filter bandwidth. Higher
resonance values produce higher gains around the frequency of cutoff
that may cause the auto-oscillation of the filter, exactly as it happens
working with analog filters.

The Gainer and Phase Inverter
This is a very basic and very useful built-in plug-in. It applies a Gain with the
option to invert independently the phase of the Left and Right channels.

External Audio Send&Return
This is a very special plug-in which sends the audio signal to an audio output
device and which gets back the audio signal from an audio input.
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It is an invaluable tool which is able to process the audio by using an
external hardware audio device. Of course, it works in real time only - for this
it is not available among the function for off-line processing.
Because DSP-AudioEditor has a built-in Output Recorder able to record to
file its own outputs, using this output recorder and the External Audio
Send&Return tool it is possible to process an audio file by an external
hardware and, getting back the audio signal, to dump it into a new file. All
this internally in DSP-AudioEditor.
This tool is useful if you have an external audio device having several I/O
ports. If this the case, just select the output device audio ports to use as
audio output to the external processor for the AUDIO SEND. Then, select
the input ports of the input device to use to get the audio signal back after
external processing on the AUDIO RETURN.
By default, DSP-AudioEditor mutes the audio returns to avoid unwanted
audio feedbacks. Be careful turning the MUTE OFF.
NOTE: it is highly recommended to use the SAME HARDWARE audio
device for both AUDIO SEND and RETURN to avoid any gap on the audio
stream. These short audio gaps can be caused by a missed hardware audio
synchronisation between Input and Output audio streams. This because if
there is not a direct sync between different audio I/O devices, the 44.1 kHz
of one device could be a little different respect the 44.1 kHz of another
hardware device, causing occasional audio gaps on audio stream.
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The Input/Output Audio Recorder
The input/output Audio Recorder of DSP-AudioEditor is able to record to file
the audio on input to the Mac as well as the audio on output from the
applications itself.
DSP-AudioEditor always creates an Audio Recorder at startup, and there is
always only one Audio Recorder.
To show the Audio Recorder, use the command Show Input/Output
Recorder ( or ⇧⌘R) from the top menu bar of the application:
DSP-AudioEditor will show the Audio Recorder oating window:

The Audio Recorder interface consists of:
- Gain sliders and Vu-Meters

these are the same elements also used by the channel strip.
- The Transport Bar

- REC button, to put a new recording on standby.
- PLAY/STOP button, to start and stop the new recording.
- New Marker button, to add a generic marker at the current recording
position.
- Time Display

fl
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- Current Recording Time: it shows the time elapsed since the start of
the recording session.
- Partial Rec Time, it shows the time elapsed since the last click on New
Marker button, ie the position of the generic marker added last.
- Time On HD: the free space on the HD used for recording.
- Other controls

- File Name and Format: they show the current file name and file format.
Clicking on it, DSP-AudioEditor shows a dialog to enter a new file name
and the audio file format to use:

It is possible to set if the new recording must be a Mono or Stereo file
and, if Mono, if the audio recorder must mix the input (or output) L&R
channels, if it must use only the L or only the R channel.
It is possible to set the Bit Depth (8, 16, 24, 32 and 32 floats) as well.
- Use Inputs/Outputs: click on Inputs button to record the audio on input
to the current audio device used by DSP-AudioEditor (refer to the
chapter about the Audio Settings to know how the set this current audio
device). Click on the Outputs button to record the audio on output from
DSP-AudioEditor.
- Left/Right popup menus: if the audio recorder is recording the inputs,
these popup menus show the list of the input audio ports to the current
audio device used by DSP-AudioEditor. If the audio recording is
recording the output from DSP-AudioEditor, these menus do not allow
other choices other than Out L and Out R channels.
- On/Off button: to turn On/Off the audio recorder
- Mute button: to mute/un-mute the output of the audio recorder.
- Next button: to switch the file to the “next” on the fly during recording.
Clicking on this button, DSP-AudioEditor closes the current recording,
automatically switching to another file, naming it with a numerical
extension to distinguish it from the closed recording. Then, DSP-
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AudioEditor continues to record on this new file. DSP-AudioEditor adds
the previous recording to the worksheet as well.
- Slave button: if ON, the audio recorder transport bar is slave to the
transport bar of the Editor window. If the audio recorder is slave, clicking
on the play/stop button on the transport bar of the main Editor window
will control also the play/stop button of the audio recorder. In any case,
to start/stop a new recording, the audio recorder must already be in
stand-by, ie its Rec button must already be turned on, otherwise nothing
happens.
NOTE: turning the Slave button ON, it is possible to dump to file in real time
the output of the audio file on the Editor.
NOTE: At startup, by default the audio recorder is muted to avoid unwanted
audio feedbacks between inputs and outputs.

How to make a new recording
This is the step-by-step procedure to make a new recording:
1) Configure DSP-AudioEditor to use the wanted audio device using the
Options->AudioSettings… menu command from the top application
menu bar, as described in the relevant chapter in this manual.
2) Make the Input/Output audio recorder visible using the Windows->Show
Input/Output Recorder… menu command from the top application
menu bar or clicking on the recorder button on top of the Editor window.
3) To make a recording from audio Inputs:
I.

Click on the Inputs button to record the audio inputs to DSPAudioEditor

II. Use the popup menu controls on the Input Channels view to set
the input ports for the L&R input channels:

The VU-Meters of audio Recorder will show the input signal levels.
4) To make a recording from DSP-AudioEditor Outputs:
I.

Click on the Outputs button to record the audio outputs of DSPAudioEditor

The VU-Meters of audio Recorder will show the input signal levels.
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5) Click on the File Name on the Audio Recorder module to enter the file
name of the new recording and the audio file format.

It is possible to set if the recording must be stereo or mono and, if mono,
if the audio recorder must mix the input L&R channels, use only the L or
only the R channel.
It is also possible to set the bit depth (8, 16, 24, 32 and 32 floats) of the
new recording.
Click on the OK button to confirm.
6) Click on the REC button to put the recording on STAND-BY. DSPAudioEditor waits to start to record (recording still does not start at this
stage). The REC button will turn ON.

7) To start recording:
I.

SLAVE mode OFF: click on the PLAY button on the Audio
Recorder Transport Bar. The counter shows the elapsed recording
time.

II. SLAVE mode ON: click on the PLAY button on the main Editor
window Transport Bar. The counter shows the elapsed recording
time.
8) To stop the recording:
I.

SLAVE mode OFF: click on the STOP button on the Audio
Recorder Transport Bar.

II. SLAVE mode ON: click on the STOP buttons on the Editor
window Transport Bar or on the Audio Recorder Transport Bar.
9) The counter stops and the PLAY button turns OFF
10) DSP-AudioEditor shows a dialog asking to keep or discard the new
recording
If the recording is ok, click on KEEP to save the new recording.
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WARNING: Discard will delete the new recording from the HD with no
chance of recovery.
11) Then, DSP-AudioEditor adds the new recording to the Document
Manager table adding it to the list of the audio files.

Double-click on the new file name row on the Document Manager table to
open the new recording on the waveform Editor view.
NOTE: during recording, it is possible to click on the New Marker button on
the Audio Recorder Transport Bar to add a generic marker at the current

cursor position. DSP-AudioEditor will save these generic markers into the
audio file at the moment of keeping the new recording into the worksheet.

Rendering to file the audio processed by an external hardware unit
To be able to use the audio Recorder as Slave to the transport bar of the
waveform editor main view is an important feature of DSP-AudioEditor which
allows to create a new file as result of the processing of an audio file through
an external hardware effect unit.
To do it, open the Input/Output Recorder, set it to record the outputs. Then,
click on the Slave button to set it slave to the waveform editor view transport
bar. Set it on Stand-by clicking on the REC button.
Return to the editor window, and as Effect on insert on the current audio file
choose the External I/O special plug-in of DSP-AudioEditor. Configure it to
send and get audio to/from the external hardware effect.
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Then, start to play the audio file on the waveform editor. The audio Recorder
starts automatically to record because it is slave. Stop when finished, keep
the new recording.
The new processed audio file will be listed on the Document manager table
among the audio files.
NOTE: to work properly, due a restriction of the internal audio routing of
DSP-AudioEditor, the sample rate of the current audio file to process must
be the same of the sample rate of the current output audio device used by
DSP-AudioEditor to play its output.
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Preferences
Use the Preference dialog to set the default parameters used by DSPAudioEditor.
The Preference dialog shows a multi-panel view which collects all the user
configurable settings, divided into the following categories:
-

General: general settings

-

AudioEditor: Waveform Editor settings

-

Audio: Audio Device settings

To open the Preferences dialog, use the Preferences… menu command
from the application top menu bar:

In upper part there are the different tabs to choose the category of
configurable settings to show on the lower part.

General Preferences
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Selecting the General tab, the above view appears.
X-Y Units Options:
-

X-Axis Units: to choose the default unit used by DSP-AudioEditor to
represent the time axes on the Time Ruler and for displaying time values.
Choose one of the possible options: hh:mm:sec:msec, Seconds,
Samples, milliseconds or AudioCD.

-

Y-Axis Units: the default unit used by DSP-AudioEditor to represent the
level of the audio signal. Possible options are: floats (-1.0, 1.0), Decibels
(dB).

Other Options:
-

AutoZero: when this option is ON, releasing the mouse after moving a
marker or setting the selection, DSP-AudioEditor automatically shifts the
cursor point to the previous zero-crossing point. A zero-crossing point is
the location in which the waveform intersects the zero level changing the
sign. This option is very useful to place markers in positions that have the
zero level in common.

-

Playback cursor returns to its starting position when the black
stops: if turned OFF, when DSP-AudioEditor stops to play, the playback
cursor remains on the last position reached.

-

Waveform drawing method: set the method used drawing the
waveform. It has a big impact at high x-axis zoom-in levels, like 1:1 or
more. Possible methods are: connected lines between samples, one dot
for each sample, one vertical line for each sample.

-

Waveform Colours: it allows you to assign the colours used to draw
waveforms and backgrounds. Use the Set Default button to restore these
settings to factory values.

Plug-ins:
-

Hide plug-in window when the application is deactivated: If OFF,
when DSP-AudioEditor goes background, all plug-in windows remains
visible on screen. Otherwise, they will disappear until DSP-AudioEditor
becomes foreground again.

-

Restore Solo ON/OFF Status for each Channel Strip: If OFF, when
DSP-AudioEditor loads a Project document, it does not restore the Solo
button status as it was when saving that Project.

Mp3 Encoder:
These are the advanced settings for the internal mp3 encoder. It is highly
recommended to keep the default values as they are if not strictly necessary.
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AudioEditor Preferences
Selecting the AudioEditor tab, this view appears:

Defaults:
-

Export ID3 Tags on Audio Files: if turned On, DSP-AudioEditor will
write also the ID3Tag chunk saving audio files. Be aware that not all
applications support ID3Tag standard. If an external application or
services has problems reading audio files generated by DSP-AudioEditor,
turn OFF this option for wider compatibility.

-

Save also extended and custom chunks for CD-Texts… Usually
custom information and additional chunks for CD-Texts are well
supported by other applications, but some hardware samplers are not
able to read these chunks on AIFF and WAVE audio files, failing to read
correctly also the loop information. Because, even if this option is turned
OFF, DSP-AudioEditor always saves the loop information on AIFF and
WAVE audio files, it is recommended to turn this option OFF when using
DSP-AudioEditor to build sample libraries for software or hardware
samplers.

-

Cut Before/After commands leave: it allows you to set two values for
the number of samples that DSP-AudioEditor will leave before and after
the cut points, when it is applicable. It is very useful doing sample editing,
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because several samplers need of some samples after the loop end to
loop correctly.
-

Compensate Loop length by: playing loops on different hardware or
software samplers, a potential problem can arise when playing loops,
because there is not a standard saying if the loop point must be
considered part of the loop or not. It means that in some cases it is
necessary to adjust of 1 sample the loop length to play it without any
audio glitch. To know if this is necessary or not, create a sine wave audio
file for testing, and place the loop points such that it plays without any
glitch using DSP-AudioEditor. Use this option if playing the same audio
file on the destination sampler there is a glitch at loop point to adjust the
loop length during the import/export until the same file plays perfectly the
same in both cases.

-

Transport Bar Cycle button is ON: if this flag is ON, the Cycle button
on the Transport bar will ON by default for new Editor windows.

Drag&Drop Audio File Export:
-

Exporting Audio Files by Drag&Drop, use: it allows to set the file
format and bit depth of the destination audio files when exporting an
audio file by Drag&Drop to the MacOS file system.

-

If there is a waveform selection, export that selection only: If OFF,
exporting by Drag&Drop to the MacOS finder will always export all the
file, even if there is waveform selection.

Audio Settings
Even if DSP-AudioEditor doesn't need any additional audio hardware to
work properly, it supports and manages all audio devices which are
compatible with CoreAudio of MacOS. To verify if an external audio device is
compatible with MacOS and DSP-AudioEditor, run the Apple Audio MIDI
Configuration utility which is into the Applications/Utility folder. If an audio
device is visible among the list of available audio devices on the Audio
Configuration window, then DSP-AudioEditor is surely be able to use it for
audio I/O.
NOTE: To assign and configure the audio device used by DSP-AudioEditor
for audio input/output, it is also possible to use the menu command on the
application top menu bar Options->AudioSettings… menu command from
the application top menu bar:

These are the options for Audio I/O settings:
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-

Audio Settings: in the upper part, two popup menus allow you to set
which I/O device must be used by DSP-AudioEditor to play on output
(output device) and to receive audio on input (input device).

Among the available devices, there is always a “System” device, which is the
one assigned as default to MacOS for audio I/O. By default, DSPAudioEditor starts using the System device.
NOTE: it is highly recommended to set the same physical audio device for
both inputs and outputs. Other settings may produce audio drop outs and
clicks.
Turning ON the Sync menu selections check box, choosing an audio
device for output and/or input, DSP-AudioEditor tries to do the same choice
for the other device (input device when choosing the output, and the
contrary) automatically. This with the purpose to assign the same physical
hardware interface for both Inputs and Outputs. It is highly recommended to
keep this option On.
-

Preferred Inputs/Outputs: these popup menus list the available audio
input or output ports available on the current audio device (ie the audio
device which is selected on the I/O Audio Device popup menu above).

These preferred Input and Output channels are the channels which DSPAudioEditor uses by default as input ports on the audio recorder and which
uses for playing its output.
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As an example, choosing the Scarlett 6i6 as input and Output audio device,
which is a multi-port audio device, this is what DSP-AudioEditor shows as a
possible choice for the preferred output channels:

And this for the preferred input channels:

96

With the above settings, DSP-AudioEditor plays always using the Mon1 and
Mon2 output audio ports of the Scarlett 6i6 audio device. Opening the Audio
Recorder to record the Inputs, the Mic1 and Mic2 are the default input ports.
It is possible to set a different audio port for audio inputs:

For outputs, if it is necessary to use a different audio port for playing outputs,
use again the Audio settings opening the Preferences dialog or from the
Options->Audio Settings menu command.
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